18422-00
4.23.2021

TABLE OF CONTENTS
1. Introduction............................................................................................... 1
2. Overview and Scientific Background.......................................... 2
3. Operation.................................................................................................... 4
3.1 Access Rights............................................................................................. 5
3.1.1 Public User Mode.............................................................................. 5
3.1.2 Power User Mode.............................................................................. 5
3.2 Starting the Program.................................................................................. 5

4. Projects........................................................................................................ 7
4.1 Overview..................................................................................................... 7
4.2 File Menu.................................................................................................... 8
4.2.1 Opening a Project File....................................................................... 9
4.2.2 File Menu Option Definitions.......................................................... 10
4.2.2.1 File > Open.......................................................................... 10
4.2.2.2 File > Save........................................................................... 11
4.2.2.3 File > Save As...................................................................... 11
4.2.2.4 File > Import....................................................................... 11
4.2.2.5 Recently Opened Project Files............................................ 15
4.2.2.6 File > Close......................................................................... 15
4.2.3 Extra Menu...................................................................................... 16
4.2.3.1 Convert tensioVIEW Project (*.TVP) Files............................ 16
4.2.3.2 Join files to an iteration file................................................ 16
4.2.3.3 Merge files to a single file................................................... 16
4.2.4 Help Menu—HYPROP-FIT Version Information............................... 17
4.2.4.1 Check for updates…........................................................... 17
4.2.4.2 User Manual....................................................................... 17
i



4.2.4.3 Info….................................................................................. 17
4.2.4.4 What is New........................................................................ 17

5. The Registers—Processing Data................................................. 18
5.1 Information Register................................................................................. 19
5.1.1 Data Groups.................................................................................... 19
5.2 Measurements Register............................................................................ 29
5.2.1 Interpretation of the Tensiometric Data.......................................... 30
5.2.2 Data Visualization Options.............................................................. 32
5.2.3 Tension Graph................................................................................. 33
5.2.3.1 Visualizing Measured Data Points...................................... 33
5.2.3.2 Visualizing Supporting Points Used
for Smooth Interpolation of Data........................................ 33
5.2.4 Using the Tensiometer Cup Air-Entry Point
as Additional Tension Measurement (Power User Only).................. 35
5.2.5 Weight Graph.................................................................................. 36
5.2.6 Tension Data Window...................................................................... 37
5.2.7 Weight Data Window....................................................................... 37
5.3 Evaluation Register................................................................................... 38
5.3.1 Retention and Conductivity Data Calculation................................. 39
5.3.2 Absolute Water Contents Calculation............................................. 39
5.3.3 Adding Independent Retention and Conductivity Data................... 41
5.3.4 Modifying Evaluation Parameters................................................... 43
5.3.5 Setting Window............................................................................... 44
5.4 Fitting Register......................................................................................... 45
5.4.1 Fitting Functions............................................................................ 45
5.4.2 Selecting a model and specifying parameter bounds..................... 46
5.4.3 Parameter Estimation and Uncertainty Measures Results............. 47
5.4.4 Function Graphs............................................................................. 48

ii

HYPROP-FIT

5.4.5 Field Capacity and Plant Available Water........................................ 49
5.4.6 Modifying Optimization Parameters............................................... 50
5.5 Export Register......................................................................................... 52
5.5.1 Output Settings.............................................................................. 53
5.5.2 Content........................................................................................... 54
5.5.3 Post-Processing............................................................................. 54
5.5.4 History............................................................................................ 55

6. Processing Multiple Data Sets..................................................... 56
7. Service........................................................................................................ 57
7.1 Customer Support.................................................................................... 57
7.2 Terms and Conditions............................................................................... 57

References..................................................................................................... 58
Appendix A. Evaporation Method Theory.................................... 59
Appendix B. Initial Water Content Automatic Estimation.. 62
Appendix C. SHYPFIT2.0 User's Manual....................................... 63
C.1 PDI Model Combinations.......................................................................... 63
C.1.1 Retention Functions....................................................................... 63
C.1.1.1 General............................................................................... 63
C.1.1.2 Adsorptive Saturation Function......................................... 64
C.1.1.3 Capillary Saturation Function............................................ 64
C.2. Conductivity Functions............................................................................ 67
C.2.1 General........................................................................................... 67
C.2.2 Capillary Conductivity.................................................................... 67
C.2.2.1 Analytical Solutions for Unscaled
Capillary Retention Functions. ........................................... 68
C.2.2.2 Analytical Solutions for Scaled
Capillary Retention Functions. ........................................... 68

iii



C.2.3 Film Conductivity............................................................................ 70
C.2.4 Prediction of Isothermal Vapor Conductivity.................................. 71
C.3. Capacity Functions.................................................................................. 72
C.4. Other Soil Hydraulic Functions................................................................ 73
C.4.1 Brooks and Corey Function............................................................. 73
C.4.2 Original Fredlund and Xing Model................................................... 74
C.5. Parameter Estimation.............................................................................. 76
C.5.1 Definition of Objective Function..................................................... 76
C.5.2 Integral Versus Classic Fit.............................................................. 77
C.5.3 Weighing Schemes.......................................................................... 78
C.6. Postprocessing........................................................................................ 79
C.6.1 Diagnostic Variables....................................................................... 79
C.6.2 Uncertainty Analysis...................................................................... 81
C.6.2.1 Parameter Uncertainties.................................................... 81
C.6.2.2 Function uncertainties....................................................... 81
REFERENCES.................................................................................................. 82

iv

HYPROP-FIT

1. INTRODUCTION
Thank you for choosing the HYPROP® 2 automated measuring and evaluation system to
determine the hydraulic properties of soil samples from METER Group.
This user manual covers the operation of the HYPROP-FIT software, a tool used to evaluate
measurements obtained using the Simplified Evaporation Method (SEM) function in the
HYPROP 2 and should be read along with the HYPROP 2 User Manual (metergroup.com/
products/ hyprop2-support/). This document includes detailed information about using
HYPROP 2 Data Evaluation Software (HYPROP-FIT) and provides scientific background related
to the function of the HYPROP 2. HYPROP-FIT is also available for download at (metergroup.
com/products/hyprop2-support).
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2. OVERVIEW AND SCIENTIFIC BACKGROUND
HYPROP-FIT is compatible with Microsoft® Windows® 7 or newer. The software reads data
that are recorded in HYPROP 2 projects by the data acquisition software HYPROP-VIEW and
stored as *.bhdx files. Separate data sets consisting of measured retention (e.g., from a
WP4C) and conductivity data (e.g., from a KSAT) can be imported and fitted, creating project
files with the extension *.fitx.
HYPROP-FIT performs the following operations:
• Specifies parameters for the evaluation of recorded experimental data with SEM, such
as column length, tensiometer positions, tare weights of the measurement device
components, the steel rings used, etc.
• Creates visual images of the raw data, such as tensions, weight changes, and specification
of start and stop points for the data evaluation.
• Recalculates tensions and net weight data as a base for the retention and conductivity
data calculation. This includes the temporal interpolation for data in low-temporal
resolution and the aggregation of data in very high-temporal resolution.
• Calculates and visualizes data for the retention and the conductivity characteristics.
• Fits state-of-the-art hydraulic functions to the data; visualizes the functions, and lists
hydraulic parameter values and confidence limits.
• Exports graphs, raw data, calculated data, fitted functions, and other parameters of interest.
HYPROP 2 measurement campaigns follow the Simplified Evaporation Method (SEM) method.
This method uses soil sample weight changes and matric potential measurements during
a drying process caused by evaporation to derive soil hydraulic functions. The principles of
the SEM method were first formulated by Wind (1968). A simplification of the SEM method,
which is implemented in HYPROP 2 measurements, was proposed by Schindler (1980).
Further advancements of the SEM method are included in the HYPROP-FIT software, such
as the extension of the measurement range towards higher suctions by using tensiometers
with boiling retardation (Schindler et al., 2010a) and a further extension of the measurement
range by considering the air-entry value of the porous cups of the tensiometers (Schindler
et al., 2010b). The validity of the SEM method has been investigated by Peters and
Durner (2008) and Peters et al. (2015). The detailed implementation of the method in the
HYPROP-FIT software follows the descriptions given in these papers. It includes features
that lead to an optimization of the method, such as a corrected fit of the hydraulic functions
by the integral method to avoid bias in hydraulic properties near saturation (Peters and
Durner, 2006), an Hermitian Spline Interpolation to the raw measured data to obtain smooth
and continuous time courses of measured data, and an automatic detection of the validity
range of conductivity data in the range near saturation, where the hydraulic gradient
becomes too small to yield reliable data. The SEM method yields correct results for soils
where the water flow is validly described by the Richards equation with time-invariant
hydraulic properties, and with hydraulic properties that can be described with parametric
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expressions, including isothermal vapour diffusion (Peters et al., 2015). For further
information about the scientific background of the method, the reader is referred to the
scientific publications listed in the references section. HYPROP-FIT is available for download
from the METER website (metergroup.com/products/hyprop2-support).
Please read all instructions before operating the HYPROP 2 to ensure it performs to its
full potential.
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3. OPERATION
Please read all instructions in this section before operating the HYPROP-FIT software to
ensure it performs to its full potential.

INSTALLATION
Use the following instructions to install the HYPROP-FIT software on a laptop or Windows PC.
NOTE: The HYPROP-FIT software is only compatible with Windows 7 or newer. It will not run on a Mac.

1.

Navigate to the METER Support / Dowloads webpage (metergroup.com/products/
hyprop2-support).

2.

Click on the HYPROP FIT & VIEW SOFTWARE DOWNLOAD link.
The Hyprop_vx.x.x.exe file will be downloaded to the Downloads folder.

3.

Double click on the Hyprop_vx.x.x.exe file to start the installation
NOTE: If there is a problem executing the file HYPROP_vx.x.x.exe, please download and install Microsoft.NET
Framework 4.5.2 manually, and be sure to have the current version of the Windows installer.

4.

Click the Next button in the lower right corner of the HYPROP Setup window.
a.

To install both HYPROP-VIEW and HYPROP-FIT software click on the Default button
to use the default installation settings (Figure 1).

b.

To install either HYPROP-FIT or HYPROP-VIEW software, do the following (Figure 1):
i.

Click on the DOWN ARROW next to the software that should NOT be installed.

ii.

Select the Entire feature will be unavailable in the dropdown list window
that appears.

iii. Click on the Next button to start the installation
This will keep the selected feature from being installed.

Figure 1 Custom Setup screens

5.

Following the instructions in the installation wizard window until installation is complete.
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3.1 ACCESS RIGHTS
HYPROP-FIT can be run in two different user modes affecting the permissions to write or change
parameters. The User Mode is depicted in the bottom line on the right of the software window.

3.1.1 PUBLIC USER MODE
In public user mode the software runs in a standard manner and default values are applied
for most specifications.
To change the user mode, select the appropriate mode from a drop-down menu located in
the lower right corner of the screen. A change of user status can be done at any time and
from any register. The change will be active immediately.

3.1.2 POWER USER MODE
Power user mode should only be used by experienced and skilled users who are trained in
soil physics and are familiar with the scientific background of data processing.
Power users mode allows the user to alter many of the default values or manipulate
measurement data.
Example
In power user mode, the user can edit or delete measured data records that are obvious outliers,
or they can delete undesired records at the beginning or end of a measurement campaign.
Furthermore, they can process data that are measured on different devices (e.g., for
evaporation experiments with different soil column heights). Changed parameters will affect
the results of the data processing, and the implications on the calculations must be known
by the users. In other words, the power user really must know what they are doing!

3.2 STARTING THE PROGRAM
To start the HYPROP-FIT software do the following:
1.

Open the Windows Start menu.

2.

Select HYPROP-FIT (or HYPROP-VIEW) from the list of programs.
On the first start of the software, a welcome screen will appear (Figure 2). The welcome
window shows three header lines:

Figure 2 Welcome screen header lines
5

Operation
NOTE: The User Survey form can be used for sending a feature request, a bug report, a question, or other comments.
Please be sure to enter a correct email address for contact.

A list of all new features and bug fixes included in the current version are listed (Figure 3).
For more information about updates, the user can do one of the following options to view a
PDF file.
• Select the two arrows (>>) at the end of each item to open a PDF with more detail.
• Select the Help menu item on the second header line and What is New from the dropdown list.

Figure 3 What is new screen

If data sets had been loaded in a previous session, HYPROP-FIT will automatically load the
data set that was used last. However, if the last exit from the software was not regular (e.g., a
crash caused by a corrupted data file), the software will open with an empty screen and data
sets will have to be reloaded.
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4. PROJECTS
The information below describes the software menus and how to set up HYPROP projects.

4.1 OVERVIEW
All commands follow the standard Windows operating system conventions used in Windows
graphical user interfaces (GUI).
The Show/Hide file explorer icon in the third header line acts as a toggle that opens and
closes a file explorer window on the left side of the main window (Figure 4).

Figure 4 Show/Hide toggle command

The Save icon opens a Save window enabling the user to name the file and choose where
the file will be saved. Command icons or entries that cannot be actively selected in a certain
situation are shown in grey and cannot be used. For example, the Save icon can only be used
if a project has been opened and modified (Figure 5).

Figure 5 Save, Save as command

A list of more possible actions associated with the menu item or icon is indicated by a
vertical triangle on the right side of the respective icon or entry (Figure 6).
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Figure 6 List of additional command actions

Entries can sometimes be selected by key-combinations. If so, the combinations are
indicated to the right of the respective entry. To return to a previous menu or action, press the
ESC button.
The following types of data can be processed in the HYPROP-FIT software:
• HYPROP binary project (*.bhdx),
• HYPROP binary iteration project (*.bhdix),
• ASCII files (*_config.csv) with a predefined data structure,
• Separately measured retention and conductivity data in ASCII files (*_RETC.csv and
*_COND.csv), stored in a *.fitx project file,
• Raw data from tensioVIEW measurement campaigns (*.tvp) performed with the HYPROP
experimental setup.
The x at the end of the filename extension indicates files that are processed with
HYPROP-FIT 3.0 and higher. This new software version uses an extended file format
compared to the previous HYPROP-FIT 2.0 versions. There is upward compatibility, meaning
old projects (e.g., *.bhd) can be opened with HYPROP-FIT 3.0, but are then stored in the new
*.bhdx format. It is not possible to open the *.bhdix (3.0) files with the previous HYPROP-FIT
version 2.0 software. The same applies to the *.bhdi and *.fit files.

4.2 FILE MENU
The File menu is used to open and save project files, and to import retention and conductivity
data measurements.

8

HYPROP-FIT

4.2.1 OPENING A PROJECT FILE
Assuming that an existing data file is available, following the instructions below to open
the project.
1.

Select File from the menu on the second header line (Figure 7).

2.

Select Open from the dropdown list (Figure 8).

Figure 7 Select File

The Open window, which looks like a file explorer window, will open.

Figure 8 File > Open window
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3.

Select the desired file by navigating in the Open window to the desired folder (Figure 8).
Only files with HYPROP-FIT compatible extensions will show in the Open window.
After opening a file, a fourth line with three to five tabs will appear. The tabs are titled
Information, Measurements, Evaluation, Fitting, and Export (Figure 9).

Figure 9 Open window

4.2.2 FILE MENU OPTION DEFINITIONS
The following subsections descript the file menu option definitions.
4.2.2.1 FILE > OPEN
The Open option is the first entry in the File menu. Table 1 describes the five types of data
files that can be opened.
Table 1 Data Types Openned With File > Open
File Type

Description

*.bhdx (Default)

A HYPROP-FIT version 3.0 (or higher) binary project file containing information,
measurement data, calculated conductivity and retention data, and fitted
function for a single measurement campaign (also the HYPROP-FIT version 2.0
format, *.bhd, can be processed).

*.bhdix

A HYPROP-FIT version 3.0 (or higher) iteration project file, including data and
fitted functions for multiple measurement campaigns (also the HYPROP-FIT
version 2.0 format, *.bhdi, can be processed).
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Table 1 Data Types Openned With File > Open (continued)
File Type

Description

*.fitx

Retention and conductivity data that were not collected with the HYPROP 2
system but saved as *.csv files with the endings *_retc.csv (including
retention data) and *_cond.csv (including conductivity data).

*.tvp

TensioVIEW data files that have been produced by a HYPROP 2 measuring
campaign and stored by the data acquisition system in a tensioVIEW project
file (review the HYPROP 2 User Manual for more tensioVIEW information).

HYPROP-FIT version 2.0 measurement files can be opened in HYPROP-FIT version 3.0 (or
higher). However, HYPROP-FIT version 3.0 (or higher) files cannot be opened in HYPROP-FIT
version 2.0 (i.e., measurement files are not backward compatible).
If there is a dataset with more than 10,000 data points, the software will not be able to
proceed with this file. By opening this file, the software automatically reduces the number of
data points by deleting every third record. The reduced file will be saved automatically as a
copy of the original file.
4.2.2.2 FILE > SAVE
The Save option is used to save a project file that has been imported or processed. All
changes will be saved in the folder under the name where it is already saved. If no changes
to an existing project have been made, the Save icon/menu entry shows as a grey shade to
indicate it is inactive.
4.2.2.3 FILE > SAVE AS...
The Save as… option is used to save a file under a different name.
NOTE: A file can be opened and processed with HYPROP-VIEW during the data acquisition stage. However, this
original file is write-protected as long as the measurement campaign continues. If desired, the file can be saved with a
different name.

4.2.2.4 FILE > IMPORT
The import function is used for HYPROP data sets that have been previously exported
and edited outside the HYPROP-FIT software, and are now ready to be imported back into
HYPROP-FIT format.
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Figure 10 File > Import window

There are three import options:
1.

Import from Microsoft Excel® (simple) spreadsheet file (*.xlsx).
If the *.bhdx file was exported as an Excel (simple) spreadsheet file (*.xlsx), it can be
imported as an Excel (simple).
Please maintain the format of the exported Excel (simple) spreadsheet file while editing:
 Heading names
 Tab names and sequences
 Column number
 Cell formats of cells
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Figure 11 Sample simple Excel spreadsheet

2.

Import comma-delimited value (*.csv)
If the *.bhdx file was exported as *.csv (simple), it can be imported as a *.csv file.
During export the software creates three files: *_config.csv, *_weight.csv; *_tension.csv.
Please keep the preset format while editing:
 Heading names
 Tab names and sequences
 Column numbers
 Cell formats
 Preset separation sign
For import, all three files (*_config.csv, *_weight.csv; *_tension.csv) have to be placed
in the same folder. Be sure to keep the preset endings of the files. All information will be
imported by selecting the *_config.csv file.
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Figure 12 Imported comma-delimited files

3.

Import Data for Fitting only.
It is also possible to import retention and conductivity data that were not collected with
the HYPROP system. For this type of data, an Excel spreadsheet file has to be created
that includes all needed data. This file must be saved as a *.csv file with following
endings: _retc (including retention data) or _cond (including conductivity data).
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Figure 13 Import data for Fitting only

4.2.2.5 RECENTLY OPENED PROJECT FILES
The group of entries below Import in the File menu are recently opened projects. This allows
direct and quick access to these projects files by selecting the project filename.
4.2.2.6 FILE > CLOSE
The Close option closes the data file. If changes have been made, a message window asking
for confirmation to save changes or not will appear.
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4.2.3 EXTRA MENU
The Extra menu item is used to do the following actions:
• Convert tensioVIEW project (*.tvp) files…
• Join files to an iteration file…
• Merge files to a single file...

Figure 14 Extra menu window

4.2.3.1 CONVERT TENSIOVIEW PROJECT (*.TVP) FILES...
This option is used to read existing tensioVIEW data files that have been produced by a
HYPROP 2 measuring campaign and stored by the data acquisition system in a tensioVIEW
project file. In the browser window that opens, navigate to the location of the files to be
imported and select. The imported file will be immediately converted to one or more HYPROP
binary data (*.bhdx) files and can be stored and further processed.
4.2.3.2 JOIN FILES TO AN ITERATION FILE...
This option is used to combine measuring campaigns that are stored as *.bhdx files to one
combined project file of type *.bhdix. It opens a browser window, from where the files that
are to be combined can be selected. This is useful to compare different measurements and
to fit retention and conductivity functions to multiple sets of data. Individual data sets will
be shown in different colors, and can be switched on and off. Please find more information in
Section 6.
4.2.3.3 MERGE FILES TO A SINGLE FILE
This option is used to merge two or more files of one measurement. This option is useful if
the software crashed during HYPROP 2 measurement (e.g., due to failure in power supply),
and the measurement was restarted after a certain time. Two parts of one measurement can
be combined again in one project by using this command.
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4.2.4 HELP MENU—HYPROP-FIT VERSION INFORMATION

Figure 15 Extra menu window

4.2.4.1 CHECK FOR UPDATES…
This optiongives information about new available software versions and provides a download
link if necessary.
4.2.4.2 USER MANUAL
This option provides the current version of HYPROP-FIT manual as a PDF document for view,
print, or download.
4.2.4.3 INFO…
This option shows the used version of the HYPROP Data Evaluation Software (HYPROP-FIT),
lists the HYPROP development team, and shows the disclaimer.
4.2.4.4 WHAT IS NEW
This option shows a PDF file describing all new features and bug fixes coming with this
software version.
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5. THE REGISTERS—PROCESSING DATA

Figure 16 Registers

The HYPROP-FIT software groups the data processing in five registers (Figure 16) that
encompass all steps of the data evaluation in a logical sequence of consecutive operations.
Normally, the registers are followed consecutively from left to right. In all registers, data
processing options can be specified, and data can be edited or manipulated by selecting the
right user mode.
The following points are common to all registers:
• Editable values are shown in an edit field (i.e., surrounded by a frame with a slightly
brighter background).
• Values that cannot be modified are just shown without the edit field.
• All variables that are expressed by numerical values are given with units. If a value is edited
by the user, the inserted numerical value must be in the given unit.
• Whether or not a variable can be edited depends on the user mode: power users can edit
more fields than public users (Section 3.1).
• When inserting a numerical value, the proper decimal separator sign depends on the region
settings of the computer. Default for the German Operating System is the comma, and
default for the English one is a dot (period).
• Fields for numerical values do not accept input of alphabetical letters or special signs; if a user
attempts to insert a nonpermitted character, the field does not show the typed character.
• To be sure that an input operation is saved, the cursor must leave the input field. This is
achieved either by pressing the Tab key, the Return key, or by moving the cursor to another
position in the window and clicking the left mouse button. In some menus an Accept button
must be pressed.
• When placing the cursor over a button, information (Quickinfo) about the button function
pops up for a period of a few seconds.
• Context-sensitive menus can be activated by right-clicking the mouse while the cursor
hovers over some graphs and other content items.
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5.1 INFORMATION REGISTER
This section described how to use the Information register to specify the required
parameters for the measurement.

Figure 17 Information register

The Information Register (the first of five tabs) is a window that contains 10 blocks providing
information about the selected project. Some of the data are editable by the Public User, and
some data are editable only by the Power User. Other data cannot be altered by the user and
are listed as information that is specified by the HYPROP-VIEW data acquisition program and
the respective firmware.
In a typical measurement evaluation, there is one single input value that has to be
specified by the user. This is the “Empty soil sampling ring weight” [g] in the group “HYPROP
parameters”. Since the sampling ring weight differs from sample to sample, the weight of the
ring must be specified for each individual measurement. Without this value, an evaluation
cannot be performed.

5.1.1 DATA GROUPS
The following paragraphs list and explain the data groups and inputs.
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EVALUATION METHOD DATA GROUP

Figure 18 Evaluation Method

This data group lists the currently used evaluation method Simplified Evaporation Method
(Schindler, 1980; Peters et al. 2015).
GENERAL INFORMATION DATA GROUP

Figure 19 General Information

Table 2 Data Group—General Information
Editable by User
Explanation

Data Value

Public

Power

Sample name

Variable

Denomination of a sample.
The name can be chosen freely by the
user. Note that the sample name is
used for the creation of the file name
during export by default. The file name
rules, specified by Windows, have to
be considered. If data stem from a
HYPROP 2 measurement campaign
with HYPROP-VIEW, the sample name
specified in HYPROP-VIEW is listed here.

Sample
name from
HYPROP-VIEW

Yes

Yes

Start of
measurement

Date and time from the start of the
recorded data. These data are given by
the *.bhdx file.

—

No

No

Stop of
measuremen

Date and time from the end of the
recorded data. These data are given by
the *.bhdx file.

—

No

No

Duration of
measurement

Difference between start and end date of
the recorded data, calculated from the
two fields above and rounded to full days.

—

No

No
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CORRECTION DATA GROUP

Figure 20 Correction

Table 3 Data Group—Correction
Editable by User
Variable

Explanation

Data Value

Public

Power

Volume correction

Correction of the sample volume. This
can be necessary for example, if the
prepared sample surface is not perfectly
prepared and shows deficits (negative
correction) or shows roughness. Volume
correction will affect the calculation
of the water contents since the weight
changes will be related to the value
volume plus volume correction.

0 cm³

Yes

Yes

Weight correction

Addition (positive) or subtraction
(negative) of a constant weight to the
tare weights, i.e., to the measuring head
and the sample ring weight, which are
subtracted from the total weight to obtain
the net sample weight. This could be the
constant weight of,e.g., a lid, a cable, or
another sensor that might be added in a
measurement campaign. In this case the
additional weight value has to be entered
as a positive value.

0g

No

Yes

GEOMETRIC PARAMETERS DATA GROUP

Figure 21 Geometric Parameters
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Table 4 Data Group—Geometric Parameters
Editable by User
Variable

Explanation

Data Value

Type of sample ring

The sample ring can be chosen between
250 ml ring (standard METER soil sample
ring) and 100 ml ring with 2-in adapter
(standard sample ring to use with the
2-in adapter from METER). If the user
already chose the used type of sampling
ring in the HYPROP-VIEW software, the
selected value is adopted.

250 ml

Public

Power

Yes

Yes

No–
Custom

A customized sample ring can also be
chosen. Geometric parameters have
to be adjusted. Selecting this sample
ring will affect the subsequent default
entries for surface area and height. Be
aware that the height ratio between soil
column height and tensiometer height
has to stay the same as for the METER
standard sampling ring height (250 ml).
If using a higher sample column, a higher
tensiometer shaft must be used.
Soil surface area

Shows the surface area of the sample,
dependent on the chosen type of
sample ring.

50.0 cm2

No

Yes

Soil column height

Height of soil sample. Default value is
given by METER standard sample rings. If
e.g. swelling occurred during saturation
and the user decided not to cut the
saturated sample to exactly 5.0 cm, this
value has to be adapted.

5.0 cm

No

Yes

Soil volume

Volume of soil sample. It is calculated
from the entries of area and height, and
corrected for the removed volume for the
two tensiometer candles (1 cm3) and the
entered volume correction.

249.0 cm3

No

No

Position above
bottom: lower
tensiometer

Height level of the ceramic tip of the
tensiometer with the short shaft,
measured from the base of the soil
sample. Default value is valid for the
METER HYPROP device, where the lower
tensiometer is located at one-fourth of
the total height.

1.25 cm

No

Yes

Position above
bottom: upper
tensiometer

Height level of the ceramic tip of
the tensiometer with the long shaft,
measured from the base of the soil
sample. Default value for the METER
HYPROP device is three-fourths of the
sample height.

3.75 cm

No

Yes
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SENSOR UNIT INFORMATION DATA GROUP

Figure 22 Sensor Unit Information
NOTE: The information in these parameter groups are not affecting the calculations; values are given purely for
information purposes.

Table 5 Data Group—Sensor Unit Information
Editable by User
Variable
Serial number

Explanation
Information given by METER firmware
through *.bhdx file.

Data Value

Public

Power

—

No

No

NOTE: This number is always unique
identification of the measurement device!
Together with the date information, it is a
unique identifier of the measurement.

Sensor unit name

Information as specified in data
acquisition and stored in the *.bhdx file.

—

No

No

Device ID

Information as given in the data
acquisition and stored in the *.bhdx
project file. Device ID can be modified
in the HYPROP-VIEW data acquisition
software. This can be necessary for
the multi-head mode, for the seldom
case that the default Device IDs of two
measuring heads are the same.

—

No

No

Tensiometer
Version

Information given by METER firmware.

—

No

No

Firmware Version

Information given by METER firmware.

—

No

No

ZERO OFFSET CORRECTION DATA GROUP

Figure 23 Zero Offset Correction
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An offset correction is required if the user has an indication from the measurement that
the calibration of a tensiometer was not correct. In general, the tensiometers must show a
difference of approximately 2.5 hPa under almost hydrostatic conditions, which prevail for
most soils in the initial measurement phase. Deviations from this difference will strongly
affect the calculation of the conductivity values at the wet end of the range. If a tensiometer
time series appears shifted by an offset, it is possible to correct the whole data set for that
shift by inserting the offset in the respective box. The correction will be directly applied to all
recorded tensions (and accordingly visualized in the Measurement register, Figure 16).
WARNING: Be careful! Please correct tensions to assumed hydrostatic conditions only when sure that these
conditions were actually given at a given time during the measurement campaign.

Table 6 Data Group—Zero Offset Correction
Editable by User
Data Value

Public

Power

Upper Tensiometer

Variable

Added offset for the measured values of
the upper tensiometer.

Explanation

0 hPa

No

Yes

Lower Tensiometer

Added offset for the measured values of
the lower tensiometer.

0 hPa

No

Yes

HYPROP PARAMETERS DATA GROUP

Figure 24 HYPROP Parameters

Table 7 Data Group—HYPROP Parameters
Editable by User
Variable

Explanation

Data Value

Public

Power

Empty Soil Sampling
Ring Weight

Exact mass of the soil sampling ring (dry
and clean).

—

Yes

Yes

IMPORTANT: This value must be specified
individually for each measurement!

The mass can be determined before
or after the HYPROP measurement.
Wrong values transfer linearly to wrong
calculated total water contents. An error
of 2.5 g leads to a shift of calculated
water contents of 1%.
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Table 7 Data Group—HYPROP Parameters (continued)
Editable by User
Variable
Measurement
Head Net Weight

Explanation

Data Value

Public

Power

Mass of the dry, clean measurement
base. The mass includes the two filled
tensiometers and the silicon sheet
used to separate the head from the
measurement base, but with no water
below the sheet. Normally, the weight is
accurately derived from the default that
is dependent on the serial number of the
head. If uncertain, then perform a control
measurement. For HYPROP devices that
are long in use, METER advises weighing
them separately. Wrong values transfer
linearly to wrong calculated total water
contents. An error of 2.5 g leads to a shift
of calculated water contents of 1%.

—

No

Yes

NOTE: DO NOT miss this silicon sheet.
Otherwise it leads to an error of approximately 8
to 10 g, which means up to 4% water content.

Air Entry Pressure
Upper Tensiometer

This value specifies the air entry pressure
of the cup of the upper tensiometer.
The value is used if the “use air-entry”
option is activated (power users only).
The default value is the statistical
mean of ceramic cups used in the 2010
series of METER HYPROP tensiometers.
For individual specifications, please
follow the detailed instructions given
by Schindler et al. (2010b). The air entry
points of the ceramic cups change with
time and use. Please verify the value from
time to time.

8.8 bar

No

Yes

Air Entry Pressure
Lower Tensiometer

Same as explained above, only for
tensiometer at lower position.

8.8 bar

No

Yes

Density of Solid
Substance

The density of the solid soil material is
by default set to the density of quartz
(i.e., 2.65 g/cm³), which in general is a
good approximation for a wide range of
soil materials. If individual data for the
soil under investigations are available,
this value can be replaced by a measured
one. The value is used to calculate the
porosity of the sample from the dry soil
weight. It is also used for the automatic
estimation of the saturated water
content, as described in Appendix C.

2.65 g/cm3

No

Yes
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SCALE INFORMATION DATA GROUP

Figure 25 Scale Information
NOTE: The information is not affecting the calculations; values are given purely for information purposes.

Table 8 Data Group—Scale Information
Editable by User
Variable

Explanation

Data Value

Public

Power

Serial number

Information given by METER firmware
through *.bhdx file.

—

No

No

Scale name

Information as specified in data
acquisition software and stored in the
*.bhdx file.

—

No

No

MEASUREMENT UNCERTAINTY

Figure 26 Measurement Uncertainty
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Table 9 Data Group—Measurement Uncertainty
Editable by User
Variable
Tensiometer

Explanation

Data Value

Public

Power

Statistical measurement uncertainty of
the tensiometer, i.e., standard deviation
of repeated tensiometer readings at
a constant physical pressure head.
The tensiometer uncertainty is used to
eliminate the conductivity values near
saturation (Peters, Durner 2008a).

0.3 hPa

No

Yes

0.06 g

No

Yes

IMPORTANT: The accuracy of the tensiometers
is related to random fluctuations (i.e., noise)
whereas offsets can lead to systematic errors.
Users must control whether the difference of
the tensions under hydrostatic conditions is
approximately 2.5 hPa. Otherwise erroneous
conductivity calculations will occur. In that
case, it is advisable to either correct the
tensiometer offset (Correction Data Group) or
increase the uncertainty of the tensiometers
if correcting the tensiometer offset is difficult
or impossible.

Scale

As for the tensiometer. The scale
uncertainty eliminates uncertain
conductivity data at the end of the
measurement campaign, when weight
changes between two consecutive
time steps become smaller than the
scale accuracy.
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NOTES DATA GROUP

Figure 27 Notes data group

Table 10 Data Group—Notes
Editable by User
Variable
Description

Explanation
Any information in tabular view.

Data Value

Public

Power

—

Yes

Yes

Default value:
- General data
- Site coordinates
- Sampling date
- Site description
- Soil type
- Land use
Soil physical data:
- Texture (%clay, %silt, %sand)
- Soil texture class
- Sampling depth
- Organic carbon content
Sample preparation and handling:
- Initial saturation procedure
- Swelling handling (suppressed, not
suppressed, under load)
Value

Any information in tabular view.

—

Yes

Yes

Free Data Field

Any informative text can be stored
here, that is usefully related to the
measurement campaign.

—

Yes

Yes
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5.2 MEASUREMENTS REGISTER
This section describes how to use the Measurements register to for visualization and editing
of measured data.

Figure 28 Measurement register

The Measurements register shows the readings of the two tensiometers and the recorded
weights. The register is composed of four windows. The two left windows show graphs of
the recorded data, and the two right windows show the numerical values. The size of the
windows can be freely scaled by positioning the mouse on the (invisible) borders of an
individual window and dragging the border to a new position. If the mouse is directly on a
border, it changes from the arrow to a double arrow. Each of the graphics windows can be
enlarged to full-screen by positioning the mouse on the window, clicking the right-mouse
button, and selecting the Maximize option in the pop-up menu. Leaving the full-screen mode
is reached by pressing the Esc key. A user can (repeatedly) magnify portions of the graphs
(even in Windows full-screen mode) by placing the mouse on the graph and drawing the
cursor to the opposite point of a rectangle with the left-mouse button held down. To reset
the window ranges, click the mouse right-button and select the Undo Zoom option.

29

The Registers—Processing Data

5.2.1 INTERPRETATION OF THE TENSIOMETRIC DATA
In a long measurement period, as shown in the example screen, we see after an initial
reaction and a plateau phase an exponential increase of both tensions, steeper for the
upper tensiometer, which is followed by a sudden collapse to smaller values. This collapse
occurs upon cavitation of the water phase in the tensiometer. Before this cavitation, the
water in the tensiometer is due to boiling retardation under a strain, i.e., under negative
absolute pressure. When the tension is so high that absolute internal pressure is below
vacuum, the liquid phase at some point suddenly ruptures and a small bubble of vapor
arises. This causes the pressure inside the tensiometer to suddenly jump from a negative
value to the vapor pressure of water. To measure this sharp cavitation point at tensions
>1000 hPa, tensiometers must be well prepared, without any gas bubbles inside, as indicated
in the HYPROP manual. The recorded tension values are reliable up to the cavitation point.
Accordingly, the cavitation point of the upper tensiometer marks the end of the data that
can be directly evaluated. The measurement has to be stopped manually by clicking on the
respective button. The “end of the data that can be directly evaluated” is automatically
detected by the software and indicated by a vertical dashed line by selecting the option
“Search Stop Point”. The stop line can be manually shifted to an earlier or later time by
placing the mouse cursor on the stop line, and dragging it to the left or to the right. The
minimum distance between start and stop has to be 2 h. The automatic detection of the stop
point can again be applied by clicking on the Search Stop Point button immediately above
the graph.
If tensiometers were not well prepared, the boiling retardation is not reached and the
sudden collapse is not visible but replaced by an asymptotic approach of the tension
towards a final value. In these cases, the automatic stop point detection is not fully
reliable, and users must carefully check the end position. As a rule of thumb, the stop
point must occur at a point where the slope of the tension curve is still increasing.
Figure 29 illustrates this for the lower tensiometer.
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Figure 29 Example stop line

After a certain time with further evaporation, the tensiometer cups will dry out and become
permeable to air, meaning that the air entry point of the tensiometer is reached. At that
time, the absolute pressure inside the tensiometers will increase from the vapor pressure
to the pressure of the ambient atmosphere. Accordingly, the recorded tension (= pressure
difference between internal water pressure and ambient atmospheric pressure) will go
down to zero.
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5.2.2 DATA VISUALIZATION OPTIONS

Figure 30 Data visualization options

In the header line above the graphs (Figure 30), buttons for data visualization options are
listed. They differ for power users and public users. The options are described in Table 11.
Table 11 Data Visualization Option Explanations
Editable by User
Variable
Search Stop Point

Explanation

Data Value

Public

Power

The stop point of the measurement is
reached by the cavitation of the upper
tensiometer, which is indicated by a
sudden pressure drop. HYPROP-FIT
detects this point automatically by
pressing on the Search Stop Point button.

Automatic

Yes

Yes

—

No

Yes

If the stop-line is moved manually to
another time, it will be reset to the
automatic detection by pressing the
Search Stop Point button again.
NOTE: Be aware that the minimum distance
between start and full stop has to be 2 hours.

If the tensiometer is not filled correctly,
the drop might not occur in that sharp
manner, since the tensiometer does not
reach a cavitation. In that case it might
be necessary that a user chooses the
Stop point manually. A good choice is
then to select the point with the highest
slope of the upper tensiometer. If the
lower tensiometer reaches the point
with the highest slope before the upper
tensiometer reaches cavitation or falls
out, then the stop point has to be set
according to the lower tensiometer.
If the air entry points are used for
evaluation, two stop lines (one for each
tensiometer) are shown. Then the stop
lines have to be set to the maximum
pressure values.
Use Air Entry Point

Activates and deactivates the use of
the air-entry point of the porous cup as
additional tension value, as described
in Section 5.2.4.
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Table 11 Data Visualization Option Explanations (continued)
Editable by User
Variable

Explanation

Data Value

Public

Power

Search Air
Entry Point

If the Use Air-Entry Point option is
activated, and the line that indicates
the time of the air-entry point has been
moved manually, pressing this button
resets to the automatic detection of the
air entry time.

Automatic

No

Yes

Show Spline
Interpolation Points

Activates and deactivates the depiction
of the supporting data points, as
described in Section 5.2.3.2.

Automatic

No

Yes

Show Data Points

Activates and deactivates the depiction
of the individual measured data points,
as described in Section 5.2.3.1.

Automatic

Yes

Yes

Reset

The Reset option resets all settings to
default values, in particular the ranges
for the visualization of the data in the
two graphs.

Automatic

Yes

Yes

5.2.3 TENSION GRAPH
The upper graph is the tension graph that normally shows two lines. The bright blue line
indicates the tensions recorded by the upper tensiometer versus time, the dark blue line the
corresponding course of the lower tensiometer. The x- and y-axes are automatically scaled
to show all recorded data. The unit can be changed between pF, hPa, kPa, MPa and bars by
opening the settings window.
5.2.3.1 VISUALIZING MEASURED DATA POINTS
The graph shows the temporal evolution of the tensions as lines without individual dots for
the data by default. If desired, a user can additionally visualize all individually recorded data
by moving the cursor on a line, right-hand clicking the mouse, and selecting the respective
option from the context sensitive pop-up menu (Mark Data Points). When this option is
activated, single data points can be easily searched in the data table by clicking on the
desired value in the graph. Data points can now be edited or deleted in the table. Deselecting
the option, the individual data points disappear again. Data can also be shown by clicking on
the respective ON-OFF button in the header line above the graph (Show Data Points).
5.2.3.2 VISUALIZING SUPPORTING POINTS USED FOR SMOOTH INTERPOLATION OF DATA
As indicated in Peters and Durner (2008), not all data are used for the calculation of the
retention and conductivity data, but just a limited number of support data that are taken
from a Hermitian Spline Interpolation of measured data. The actual number of these support
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data can be selected in the submenu Edit Interpolation Parameters in the Evaluation register
(Figure 31). Supporting data can be visualized by clicking on the on-off toggle Show Spline
Support Points button in the header line directly above the graph.

Figure 31 Number of RETC data
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Figure 32 Show spline interpolation points

5.2.4 USING THE TENSIOMETER CUP AIR-ENTRY POINT AS ADDITIONAL
TENSION MEASUREMENT (POWER USER ONLY)
It is possible to extend the range of the tensiometric measurements by using the air-entry
value of the ceramic tensiometer cup as an additional measuring point (Schindler et al.,
2010b). The HYPROP-FIT includes this option for Power Users. The air-entry point is located
at the time where the sudden pressure drop of the tensions to zero occurs. This option is
only viable if the sharp drop towards zero tension is really recorded (i.e., if the measurement
campaign was performed long enough).
Clicking on the Use Air Entry Point button will add an extra measurement point for each
tensiometer that has reached the point where air passes the tensiometer cup. At that point
in time a tension that is specified in the Information register > HYPROP Parameters is used
to measure tension of the respective tensiometer. The Use Air Entry point button is an on-off
switch. Hence, to deactivate the use of the air-entry point, press the button again. At the
time axis of the air-entries of the two tensiometers, vertical lines will be shown. If the drop
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of the tension is not clearly indicated by the course of the data, the automatic detection of
the air-entry point will fail. The vertical air-entry line is then at a wrong position, but can be
moved with the cursor, as described above for the stop point position. After manual shifting,
the original position due to the automatic detection can be again recovered by pressing the
Search Air Entry Point button.
When the Use Air Entry Point option is active, dashed lines are shown that interpolate the
tensiometric data between the last reliably measured points (stop point) and the air entry
points of both tensiometers. For the HYPROP-FIT calculations, the tensiometric value of the
lower tensiometer will be taken from this interpolation. For further information about using
this option, the user is referred to the publication of Schindler et al. (2010b).
Keep in mind that the air entry point of the ceramic cups changes with time and use. Please
verify the value from time to time.

5.2.5 WEIGHT GRAPH

Figure 33 Weight graph

The lower graph (Figure 28) is the weight graph. It shows a grey line that indicates the net
weight of the sample, i.e., the mass of dry soil plus the mass of water. The accuracy of the
absolute level of these data depends on the accuracy of the values for the measurement
head and the soil sampling ring, and possibly additional weights, as described in the
Information register. The accuracy of the weight changes, i.e., the relative accuracy, is equal
to the accuracy of the used scale. The times of the Stop and the Air-entries are shown by
vertical lines, at identical positions to the tension graph.
The x- and y-axes are automatically scaled to show all recorded data. Parts of the graph can
be manually enlarged and reset as described for the tension graph. Note that changing the
time axis of the weight graph does not affect the tension graph, and vice versa. Visualization
of the actually measured points and the spline support points can be activated and
deactivated as described for the tension graph.
Interpretation of the weight data. In a typical measurement, the weight data will first
show a continuous weight loss with an almost constant rate, which reflects the potential
evaporation rate in the laboratory environment. Small changes in slope can be caused by
temperature fluctuations in a lab, with the respective changes in relative humidity. The
period of a constant weight loss rate is called “Phase 1” evaporation, and water loss during
that phase is controlled by atmospheric conditions. Afterwards, the rate drops, and the slope
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of the weight curve becomes less steep. This second phase is called “Phase 2” evaporation.
The water loss rate is now controlled by the resistance of the drying soil near the soil
surface. In the depicted data example, the “Phase 2” evaporation starts at the time when the
upper tensiometer reaches its air-entry value. For further information see Peters and Durner
(2008), and Schindler et al. (2010, 2011).

Figure 34 Phases of weight curve

5.2.6 TENSION DATA WINDOW
The window at the upper right (Figure 28) shows the recorded tensiometric data, together
with the times and the temperature. The latter is for information purposes, and not used in
the data evaluation. The data window can be scrolled by the scroll bar to the right. By moving
the cursor into the data window, and clicking on the right-hand mouse button, the data can
be directly edited by Power Users. Possible operations are deletion of lines and changes of
the contents of individual data cells. Also, multiple lines can be selected, and the data can
be copied using the Ctrl+c keyboard combination. Manipulation of data or deletion of data
(for power user mode only) will immediately be shown in the graph to the left. By selecting
one single measurement point in the graph, the table automatically switches to this
measurement line.

5.2.7 WEIGHT DATA WINDOW
The window at the lower right shows the recorded weight data. After date and time
(column 1), the total weight of the measuring system, including all tare weights is listed
(column 2). The net weight of soil plus water is calculated from the total weight minus the
tare weights, as specified in the “Information” register, and listed in column 3. These data
are also depicted on the graph to the left. Finally, the net weight change from the start of
the experiment is listed in column 4. The data window can be scrolled by the scroll bar
to the right. By moving the cursor into the data window, and clicking on the right-hand
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mouse button, the data can be directly edited by Power Users. Possible operations are
deletion of lines and changes of the contents of individual data cells. Also, multiple lines
can be selected, and the data can be copied with the “ctrl+c” option. Manipulation of data
or deletion of data (for power user mode only) will be immediately shown in the graph to
the left. By selecting one single measurement point in the graph, the table automatically
switches to this measurement line.

5.3 EVALUATION REGISTER
The following section describes how the Evaluations register is used with calculating
retention and conductivity data.

Figure 35 Evaluation register window

The Evaluation register shows five data groups in the upper part with specifications for the
calculation of absolute water contents, calculated parameters, and three menus for adding
additional data points. In the lower part, up to three graphs of the resulting retention and
conductivity data are shown. The first graph shows the volumetric water content versus pF
(= decimal log of tension, expressed as pressure head in the unit of cm). The second graph
shows the log of the hydraulic conductivity versus pF, and the third graph the log of hydraulic
conductivity versus volumetric water content. The individual graphs can be switched on or
off by pressing the respective buttons that are located immediately above the graphs, to the
left. Switching a graph on or off will resize the remaining graphs.
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By right clicking on one of the graphs, the front size can be changed between small, medium
and large and the graph can be maximized. For the first and the second graph there is also
the possibility to change between linear or log scaling of the x-axis. Also the units of the
x-axis can be chosen between pF, hPa, kPa, MPa and bars.

5.3.1 RETENTION AND CONDUCTIVITY DATA CALCULATION
The calculation of retention and conductivity data from the measured tensions and weight
changes follows the Simplified Evaporation Method as outlined by Schindler (1980),
Schindler et al. (2010 a,b), Peters and Durner (2008) and Peters et al. (2015). For the
theoretical background of the calculations, the reader is referred to this literature. In the
calculations, only the tensions and weights in the time window between start time and stop
time, which is specified in Section 5.2, are considered.

5.3.2 ABSOLUTE WATER CONTENTS CALCULATION
The relative shape of the water retention data is fully determined by the recorded weight
change. The absolute level of the water retention data is additionally affected by the
parameters that can be specified in the parameter group Calculation of water contents.
OPTION 1: INITIAL WATER CONTENT CALCULATION FROM DRY SOIL WEIGHT

Figure 36 Water content calculation

This is the option of choice if the dry soil weight has been determined after the end of the
measurement, by oven-drying at 105 °C for 24 h. The exactness of the result depends on
the correctness of all involved parameters that are specified in the Information register.
From the data, further soil physical parameters such as the initial water content, the
porosity and the dry bulk density are also calculated and shown in the underlying group
Calculated Parameters.
NOTE: Only option 1 leads to a 100 % correct calculation of the absolute water content.
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OPTION 2: USER-SET INITIAL WATER CONTENT EXTERNAL SETTING

Figure 37 User-set water content calculation

This option allows a user to externally set the initial water content to a desired value (from
wherever he takes this value). Since the saturation state associated with the externally set
initial water content is unknown, no calculation of porosity, dry bulk density and dry soil
weight is possible, and no values of these parameters can be shown.
OPTION 3: INITIAL WATER CONTENT AUTOMATIC ESTIMATION

Figure 38 Initial water content estimation

If the dry weight of the soil is not yet available, the initial water content of the measurement
can be estimated automatically by the software assuming an initially full saturation of
the pore space (i.e., initial saturation = 100 %). In practice, this will rarely be reached; the
calculated water content is therefore to be seen as an approximation of the true one. As a
result of the assumptions, the initial water content, the porosity, the bulk density and the
dry soil weight can be calculated. These values are shown in the underlying group Calculated
Parameters. Details of the automatic calculation are provided in Appendix B.
If the mode of the initial water content calculation is changed, the user-edited values for the
dry soil weight and for initial water content remain in storage. This allows a user to switch
between the options and to conveniently compare the outcomes of the different calculation
options, without losing the inserted information. Be aware that the calculation is always
based on the chosen option.
IMPORTANT: The calculation of porosity and absolute water content depends on the correctness of all involved
parameters that are specified in the “Information” register, in particular on the correct dry bulk density (Default:
2.65 g/cm³), mass of the measuring head, mass of the sampling ring that contains the sample, and mass of dry
soil which is specified in the Evaluation register. Any error in these data will be linearly transferred to the results.
Furthermore, overfilling or underfilling of the sampling rings with soil will cause appreciable errors. As a rule of thumb,
1-mm error in sample height causes about 2% error in the calculated data.
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5.3.3 ADDING INDEPENDENT RETENTION AND CONDUCTIVITY DATA

Figure 39 Add independent retention and conductivity data

Users can add independently measured data from the METER WP4C or pressure plate
measurements as well as conductivity measurements taken with the METER KSAT®.
If the respective volumetric water content for the additional water potential point is already
calculated, the values can be added in the first table. Entering water potential, gross wet
mass, gross dry mass and tare mass in the third table, HYPROP-FIT automatically calculates
the water content.
The entered data points are displayed as filled dots in the graphs below, whereas the
HYPROP-measured data are shown as empty circles.
Please care for the appropriate units when adding the data: tensions must be added in the
displayed units which can be changed in the settings, conductivity data has to be added
as a decimal log of the value expressed in cm per day. Also please care for the regional
conventions for the decimal separator (comma or dot), as specified in the Windows System
Software. Added data can be edited and deleted. Upon a right-hand mouse click, a pop-up
menu appears:

Figure 40 Edit independent retention and conductivity data

As an additional feature, retention and/or conductivity points can be read from Excel data
files (.xlsx) or inserted with using copy and paste instead of entering manually. This is of
particular advantage if many points are available from independent measurements.
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By using copy and paste, please be sure to keep the right numbers of fields (maximum of
three fields for the Add retention data points table and the Add conductivity data points;
maximum of six fields for the Add WP4 data points table) and the correct sequence. Also
please care for the regional conventions for the decimal separator (comma or dot), as
specified in the Windows System Software. The insertion starts in the current active field.
By using the Add points from file option, please be sure to keep the right numbers of fields
(maximum of two fields for the Add retention data points field and the Add conductivity data
points; maximum of four fields for the Add WP4 data points table) and the correct sequence.
Also please care for the regional conventions for the decimal separator (comma or dot),
as specified in the Windows System Software. In addition it is necessary to have the same
heading as the columns of the tables. The insertion starts in the first new line.

Figure 41 Adding WP4 data points file format

Figure 42 Adding retention data points file format
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5.3.4 MODIFYING EVALUATION PARAMETERS

Figure 43 Edit interpolation parameters

The parameters for raw data interpolation can be edited in a submenu, which pops up when
clicking on the respective Edit Interpolation Parameters button on the right side of the
header line in Evaluation register. The interpolation parameters are described in Table 12.
Table 12 Interpolation parameters
Editable by User
Variable
Interpol

Explanation

Data Value

Public

Power

Determines the interpolation mode for
the measured data:

2

Yes

Yes

100

Yes

Yes

1: piecewise_linear
2: hermitian_splines
Number_of_RETC_data

Number of support points for
hydraulic functions (<1000). Note
that this number is valid for the
resulting retention data. Internally
the same number of conductivity
data is calculated but the invalid
data near saturation are not shown.
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Table 13

Interpolation parameters (continued)
Editable by User

Variable
Tensiometer_Mean

Explanation

Data Value

Public

Power

Determines the calculation mode for
the mean tension for the calculation
of the water retention curve points:

3

Yes

Yes

0.5

Yes

Yes

1: arithmetic
2: geometric
3: mixed (see Peters et al. 2015)
TPower

Determines the spacing of the support
points for the spline interpolation.
A value of 1 means equal spacing in
time, a value of 0.5 means a spacing
that is proportional to the square root
of time. Recommended values are
between 0.5 and 1.

5.3.5 SETTING WINDOW

Figure 44 Setting window

By selecting the settings button in the upper right corner a setting window appears. Here the
user can select the unit for the data values as well as for the charts. Furthermore base points
can be added and customized. Also export folder and format can be selected. By ticking the
box, the export files will be saved in the same folder as the measurement file. It is also possible
to customize the export template. The default template is saved on the local drive in the same
folder as the software. This template can be copied and edited. The user can delete, add or
change information (except the fields in brackets as these are filled automatically).
By applying OK these settings are set as default for all further measurements.
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5.4 FITTING REGISTER
This section describes how the Fitting register fits hydraulic functions to the data.

Figure 45 Fitting register

For use in numerical modeling, hydraulic characteristics are described by parametric
functions for θ(h) and K(h), or K(θ), where θ is the volumetric water content, K the hydraulic
conductivity and h the matric potential. HYPROP-FIT provides a high-class algorithm to fit a
wide variety of functional relationships of the retention curve and the conductivity curve to
the data. No specification of initial guesses for the parameter values is required.
Sixteen widely-used retention models are available, encompassing the expressions of
Brooks and Corey, Fredlund-Xing, Kosugi and van Genuchten with and without parameter
constraint for the parameter m. With the exception of Brooks-Corey model, all functions are
available as PDI-variant in uni- and bimodal form. The PDI-variant ensures that the water
content matches zero at oven dryness, and it considers the effect of water in capillaries, in
films and in corners of pores, in both the retention function and conductivity function. All
models are described in Appendix C.

5.4.1 FITTING FUNCTIONS
The Fitting register contains a header line with the fit button (Curve Fitting) and the option of
editing “Optimization Parameters” at left, and a button for “Restore Parameters” at right. The
data to be fitted are shown together with the fitted functions in the graphs in the lower part
45

The Registers—Processing Data

of the window. The non-linear parameter optimization is subject to constraints and settings,
which are defined in the submenu “Optimization Parameters” (see section 5.4.6). The “Restore
Parameters” button will reset all values for the parameter bounds to the default values.
To fit the selected hydraulic functions to the data, click on the Curve Fitting button. A
window will pop up (Figure 46) that indicates that the fitting routine is running. This process
can last as long as a few seconds or as long as 1 or 2 min, depending on the selected model
and the number of data points. It cannot be stopped or otherwise interrupted.
NOTE: In cases where the fitting will apparently not lead to a stop, the user can cancel the process in the Windows
Task Manager.

Figure 46 Fitting process window

The fitting algorithm minimizes the sum of squares deviations between data points and
fitted functions. Conductivity data are fitted on a log K scale, because otherwise the large
conductivity data would completely dominate the fitting result. Fitting both data types
simultaneously is a multiobjective problem, and improving the fit for the retention data
sometimes can be only accomplished by a worse fit for the conductivity data, and vice versa.
The balance between fitting accuracy for the retention data and the conductivity data is
specified by default with a stronger weight for the retention data, but the parameters can be
modified by power users to any desired weighting scheme (Section 5.4.6).

5.4.2 SELECTING A MODEL AND SPECIFYING PARAMETER BOUNDS
A hydraulic model is selected by marking the respective tick box. By default, all model
parameters are included in the fitting process (except the parameters `pF_dry` and `a` for
the PDI models), and allowed to vary within a predefined range. The ranges of values are
wide enough to cover physically consistent parameter combinations. A user can alter the
permissible values of the bandwidth, by changing the default minimum and maximum
value, but for most soils, this will not be necessary. In other cases, users may have prior
knowledge about parameters that can lead to much reduced bandwidths, which speeds up
the convergence of the algorithm.
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Changing the default values for the minimum and maximum parameter values is done by
typing the new value into the respective field in the group “Retention function parameters”
and “Conductivity function parameters”. To store a typed value, the cursor must be positioned
out of the field, which can be done by pressing the “Tab” or “Return” key or by moving the
mouse to another field. Default values can be re-entered by selecting “Restore Parameters”.
If the tick-box in front of the parameter is selected, the value will be calculated
automatically. By deselecting the tick-box, the default value is shown and the value can be
entered manually. If a model selection is changed, the user is asked if he wants to keep the
manual changed values for the fitting parameter or not.
NOTE: For the decimal separator (i.e., appropriate use of comma or dot in the inserted numbers), the regional
conventions of the Windows system is used.

5.4.3 PARAMETER ESTIMATION AND UNCERTAINTY MEASURES RESULTS
After termination of the fitting process, the appearance of the parameter fields switches
from the input mode to the results mode. In results mode, the optimized parameters are
shown in the previously empty column with the “Value” fields, and the uncertainties of the
individual parameters are indicated by 95% confidence limits for the parameter values
(expressed by the 2.5% quantiles and the 97.5% quantiles in the following two columns).
The mathematical background for the calculations of uncertainties is given in Appendix C
(SHYPFIT2.0). For fixed parameters, the uncertainty is of course zero.
The quality of the fits is quantified in the group “Statistical Analysis” in the upper right
and can be visually inspected from the graphs. Fit quality is given in terms of the root
mean square errors, separately calculated for the water content data (RMSE_TH) and the
log of conductivities (RMSE_K). The root mean squared error is an indication of the mean
distance between a data point and the fitted function. An RMSE of 0.001 for the retention
data fit indicates an average distance of the fitted curve to observed data of 0.1% water
content. Models with a higher number of parameters are generally more flexible; hence
the fitting error will become smaller for models with a larger number of parameters. This
is counterbalanced by a higher correlation between the optimized parameters and higher
uncertainties for the individual parameters.
As an aid in deciding which model is most appropriate, HYPROP-FIT additionally shows the
corrected Akaike Information Criterion (AICc, Akaike, 1974; Hurvich, Tsai, 1989) in the field.
This criterion accounts for the different number of adjustable parameters when selecting
the best model. The value will normally be negative. The smaller the value (i.e., the larger the
absolute number), the more appropriate is the model. Note that the actual value of the AICc
has no meaning. It can only be used to compare different model fits for one set of data. For
details on the statistical criteria, see Appendix C (SHYPFIT).
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The effect of the parameter uncertainties on the uncertainties of the fitted functions
can furthermore be visualized in the graphs by a grey-shading of the uncertainty bands.
This option is only available for Power Users by selecting the respective option in the
Optimization Parameters menu (Section 5.4.6).
As indicated above, models with a higher number of parameters are generally more
flexible. But will have a higher correlation between the optimized parameters and higher
uncertainties for the individual parameters. Pressing the button “Parameter Correlation
Matrix” will cause the pop-up of the parameter correlation matrix.

Figure 47 Correlation matrix

In this symmetric matrix, the linear correlation coefficients of the parameters are listed.
Negative values indicate that the increase of one parameter value can be (partly) balanced
by a decrease of the other; positive values mean that an increase of either parameter value
has a similar effect on the overall fit of the functions. Generally, correlation coefficients
with absolute values smaller than 0.95 are not problematic and indicate a well-posed fitting
problem. Too-high correlation of parameters is undesirable, since it indicates an overparameterization of the selected model.

5.4.4 FUNCTION GRAPHS
In the lower part of the “Fitting” register window, graphs with the calculated HYPROP data,
the added data, and the fitted hydraulic functions are shown. The 95% confidence intervals
are shown here as grey shaded areas if selected before. The individual graphs can be
switched on or off by pressing the respective buttons that are immediately above the graphs,
to the left. Switching off a graph will resize the remaining graphs.
As with any other graphs in the HYPROP-FIT software, the graphs can be magnified to full
screen, or zoomed, by selecting the respective option in the context-sensitive submenu,
which is activated by a right mouse click.
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The fitted functions will disappear from screen if either parameter settings are changed
(e.g., by modifying the permissible data range), or a setting in another register is changed
that affects the calculated HYPROP data. After the fitting process, the fitting results can
be exported in a variety of ways and graphs, which is specified in the final Export register
(Section 5.5).

5.4.5 FIELD CAPACITY AND PLANT AVAILABLE WATER

Figure 48 Field capacity

Retention curves are often determined to get estimates of field capacity and plant available
water. HYPROP-FIT shows the corresponding values immediately after each fit. The
calculation is based on the fitted curves and encompasses:
WC@6 kPa = water content at pF 1.8 (i.e., field capacity for conditions with close
groundwater level)
WC@33 kPa = water content at pF 2.5 (i.e., field capacity for conditions distant
to groundwater)
WC@1500 kPa = water content at pF 4.2 (i.e., at the wilting point)
PAW 6 … 1500 kPa = plant available water as difference of water contents at 6 and
at 1500 kPa
PAW 6 … 1500 kPa = plant available water as difference of water content at 33 and
at 1500 kPa
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5.4.6 MODIFYING OPTIMIZATION PARAMETERS

Figure 49 Edit fitting parameters

Users can edit some of the parameters that specify the calculations and the depiction
of the fitted functions. The specifications are listed by selecting the button Optimization
Parameters and described in Table 13.
Table 13 Optimization Parameters
Editable by User
Variable
Number_HYDFUNC

Explanation
The hydraulic functions in the graphs
are taken from internal tables, where
the functions are listed in the range
PFBOUNDS_LOWER to PFBOUNDS_
UPPER at discrete supporting points.
Number_HYDFUNC is the number of
supporting data points to depict the
hydraulic functions.

Data Value

Public

Power

500

Yes

Yes

–3

Yes

Yes

NOTE: This also affects the number of data
written in the exported tables.

pF_lowerbound

Lower bound for internal table of
hydraulic functions, expressed as pF
(=log10(h) with h in cm). The default
value expresses a minimum tension of
0.001 cm.
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Table 13

Optimization Parameters (continued)
Editable by User

Variable

Explanation

Data Value

Public

Power

pF_upperbound

Upper bound for internal table of
hydraulic functions, expressed as pF
(=log10(h) with h in cm). The default
value is pF = 7, which is a tension of
10,000,000 cm.

7

Yes

Yes

Show_Uncertainty_Bands

Flag for showing the 95% uncertainty
bands for the fitted functions in the
depicted graphs by a grey shading.

False

Yes

Yes

WEIGHT_FLAG

The simultaneous fit hydraulic
functions to retention data and
conductivity data is a multiobjective
minimization problem, which requires
weights for the data of the different
data types. HYPROP-FIT provides the
possibility to either prescribe these
weights, or else to let the software
iteratively balance out the weights
in a way that both data sources
(retention points and conductivity
points) contribute in the same order
of magnitude to the total fitting error.
Since the retention data are normally
better determined and cover a wider
moisture range, we recommend to use
the default values, where the weighting
of the conductivity data is enhanced by
a factor of 103.

2

Yes

Yes

0.001

Yes

Yes

1.0

Yes

Yes

0: weights for data classes as specified
by user (parameters wk and wtheta),
internal weights in each class are
scaled by distance to neighbouring
data points
1: as 0, but weights for data classes are
calculated automatically as described
by Peters and Durner (2008)
2: as 0, but data of same type have all
the same weight (= default)
wk

Weight of the conductivity data class.
Default = 0.001

wtheta

Weight of the retention data class.
Default = 1.0
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5.5 EXPORT REGISTER
This section describes how the Export register supports exporting data, graphs, functions
and parameters.

Figure 50 Export register

The Export register allows the export of all graphs, raw data, calculated data, fitted
functions, and other parameters of interest. User specifications for data format, file name
convention and directory will be kept as default as long as the user remains in this session.
HYPROP-FIT supports the following output file formats (Table 14):
Table 14 Output File Formats
Variable
xlsx

Explanation
Microsoft Excel file format. The Excel file will contain all relevant data in
different sheets:
• Configuration and information
• Measured raw data
• Data from spline interpolation used to derive retention and
conductivity data
• Retention and conductivity data
• Data of fitted curves
• Parameters of fitted models
• Fitted model parameter uncertainties
• Base points (if specified)
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Table 14

Output File Formats (continued)

Variable
xlsx (simple)

Explanation
Microsoft Excel file format for import (File >Import menu) into HYPROPFIT software.
The Excel file will contain one sheet with parameters and one sheet with
the measurement data (tension and weight).

HYDRUS table

File named MATER.IN, readily formatted for direct use in HYDRUS
simulations. The file contains retention curve, specific water capacity,
and conductivity data.

csv

Comma-separated values, for editing with any external program.

csv (simple)

Comma-separated values for re-import into HYPROP-FIT software. Creates
three files <name>_Config.csv, <name>_Tension.csv, <name>_Weight.csv,
which contain the respective data. These files can be manipulated outside
of HYPROP and imported using the File >Import menu.

5.5.1 OUTPUT SETTINGS
Different output settings are available and described below. To export, left-click on the
Export button.
FILE NAMING

Figure 51 File name

Enter the output file name in the field Filename format. All permitted characters can be
used in the file name. The two default settings <Date> and <Sample name> are available for
optional use in any position within the file name. They will automatically be replaced by the
current date or sample name.
FILE FORMAT

Figure 52 File format
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Select different file formats in the pull down menu.
DIRECTORY

Figure 53 File name

Enter the output directory in the Directory field or click on the Browse button to select a directory.

5.5.2 CONTENT

Figure 54 Edit fitting parameters

In the Content group, select the check boxes for the data that should be exported, and enter
the base points for export.
In the Diagrams group, select the checkboxes for the diagrams that should be exported.
In the Data group, set the options for exporting raw data, calculated values and fitted functions.
These functions are only available for export formats .xlsx and .csv.
It is possible to enter freely definable base points for which the correlating data points will
be calculated. To do so, enter the desired value in the table, and correlating data points are
automatically calculated and exported when exporting is executed. Left-click the Update
button to update the data points.

5.5.3 POST-PROCESSING

Figure 55 Post-processing
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In the Post-Processing group, set different actions that should be executed either after
exporting or immediately at exporting.

5.5.4 HISTORY

Figure 56 History

The History group gives an overview of all recently executed exports.
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6. PROCESSING MULTIPLE DATA SETS

Figure 57 Multiple data sets

HYPROP-FIT offers the convenient and powerful option to assemble individual data sets
to combined data sets in so-called HYPROP binary iteration projects (files with extension
*.bhdix). This is of particular use if data sets are to be compared, or if multiple data sets are
to be fitted with a single hydraulic function.
The process to combine the individual *.bhdx files to a *.bhdix project is described in
the Extras command menu, Section 4.2.3. Once individual measurement campaigns are
combined, they can be activated and deactivated simply by clicking on the individual tick
boxes in the file explorer.
Data from different campaigns are shown in different colors. Fitting of functions occurs
simultaneously for all depicted data.
Individual data sets can be fully edited and processed by single-clicking on the respective
campaign name in the file explorer. The source file for the data will be unaffected (i.e., the
*.bhdix file contains copies of the original data). Clicking on the *.bhdix name will return to
the combined project menu (Figure 57).
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7. SERVICE
This section customer service information.

7.1 CUSTOMER SUPPORT
NORTH AMERICA
Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 7:00 am to 5:00 pm Pacific time.
Email:

support.environment@metergroup.com
sales.environment@metergroup.com

Phone:

+1.509.332.5600

Fax:

+1.509.332.5158

Website: metergroup.com
EUROPE
Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 8:00 to 17:00 Central European time.
Email:

support.europe@metergroup.com
sales.europe@metergroup.com

Phone:

+49 89 12 66 52 0

Fax:

+49 89 12 66 52 20

Website: metergroup.de
If contacting METER by email, please include the following information:
Name

Email address

Address

Instrument serial number

Phone

Description of the problem

NOTE: For products purchased through a distributor, please contact the distributor directly for assistance.

7.2 TERMS AND CONDITIONS
By using METER instruments and documentation, you agree to abide by the METER Group,
Inc. USA Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.

57



REFERENCES
Akaike, H. 1974. A new look at statistical model identification, IEEE Trans. Autom. Control,
AC-19, 716–723.
Peters, A., and W. Durner. 2006. Improved estimation of soil water retention
characteristics from hydrostatic column experiments, Water Resour. Res., 42, W11401,
doi:10.1029/2006WR004952.
Peters, A. and W. Durner. 2008a. Simplified Evaporation Method for Determining
Soil Hydraulic Properties, Journal of Hydrology 356, 147–162, doi:10.1016/j.
jhydrol.2008.04.016.
Peters, A. and W. Durner. 2008b. A simple model for describing hydraulic conductivity in
unsaturated porous media accounting for film and capillary flow, Water Resour. Res., 44,
W11417, doi:101029/2008WR007136.
Priesack, E., and W. Durner. 2006. Closed-form expression for the multi-modal unsaturated
conductivity function, Vadose Zone Journal 5:121-124.
Schelle, H., S.C. Iden, A. Peters, and W. Durner. 2010. Analysis of the agreement of soil
hydraulic properties obtained from multistep-outflow and evaporation methods, Vadose
Zone Journal, 9:1080-1091, doi:10.2136/vzj2010.0050.
Schindler, U. 1980. Ein Schnellverfahren zur Messung der Wasserleitfähigkeit im
teilgesättigten Boden an Stechzylinderproben. Arch. Acker- u. Pflanzenbau u. Bodenkd.,
Berlin 24:1-7.
Schindler, U., W. Durner, G. von Unold, and L. Müller. 2010a. Evaporation Method for
Measuring Unsaturated Hydraulic Properties of Soils: Extending the Measurement Range ,
Soil Sci. Soc. Am. J., 74:1071-1083, doi: 10.2136/sssaj2008.0358.
Schindler, U., W. Durner, G. von Unold, L. Mueller, and R. Wieland (2010b): The evaporation
method – Extending the measurement range of soil hydraulic properties using the
air-entry pressure of the ceramic cup, J. Plant Nutr. Soil Sci., 173(4):563–572, doi:
10.1002.jpln200900210.
Wind, G.P. 1968. Capillary conductivity data estimated by a simple method. In: Proc. UNESCO/
IASH Symp. Water in the unsaturated zone. Wageningen. The Netherlands. 181-191.
van Genuchten, M. Th. 1980. A closed-form equation for predicting the hydraulic conductivity
of unsaturated soils. Soil Sci. Soc. Am. J., 44:892-898.

58

HYPROP-FIT

Appendix A. EVAPORATION METHOD THEORY
This appendix describes the theory behind the HYPROP.
In a soil sampling ring two tensiometers are installed at two depths (z1 and z2). The middle
height between the sensing tips of the tensiometers is the central plane of the soil sample.
The sample is saturated, closed on the bottom, and placed on a scale. The upper side of the
sample is open to the atmosphere so that the soil water can evaporate. From the soil water
tension [hPa] the average matric potential and the hydraulic gradient is calculated. The mass
difference, measured by the scale, is used to calculate the volumetric water content and the
water flow rate.
A measuring campaign will last until one of the tensiometers runs dry, the mass changes
become marginal, or, if the air entry values of the tensiometers is used, until both
tensiometers reach the air entry value. Then, the dry weight of the soil is determined by
oven drying the sample at 105 °C for 24 h. With these values the retention curve and the
unsaturated conductivity is calculated as described next.
First, an interpolation scheme is applied to the raw data for the measured time series of
tensions and weights to get N interpolated data for each data series at the same times, ti. The
user can choose between linear interpolation and Hermitian spline interpolation. As default,
the HYPROP-FIT software uses Hermitian spline interpolation and N = 100.
The total mass of water wi, at time ti is derived from the weight measurements at time ti by
subtracting the weights of the tare components from the total weight wtot (i) recorded by the
HYPROP balance at times ti. The tare weights in a standard HYPROP measurement campaign
are the weight of the empty steel cylinder wcyl, the weight of the HYPROP base including
the tensiometer shafts and the silicon mat wHYP, and the weight of the dry soil wsoil. Thus,
wi = wtot (i) – wcyl - wHYP – wsoil. Dividing wi by the density of water, which is assumed to be equal
to 1 g/cm-3, gives the water volume Vw [cm3]. The mean water content of the column, θi [–] at
time ti is computed by dividing the volume of water by the column volume V.
To obtain water retention data pairs, the mean water contents at time
ti−1/ 2 =

1
(t + t )
2 i−1 i

Equation 1

θi + θi−1
2

Equation 2

are calculated by
θ i−1/ 2 =

In the original data evaluation (Peters and Durner, 2008, Schindler et al., 2010), the
arithmetic mean of the four measured suctions, h [cm] is used as shown in Equation 3,
h ari ,i−1/ 2 =

h1,i + h1,i−1 + h2,i + h2,i−1
4
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where subscripts 1 and 2 represent the location of the tensiometers (i.e., 1 is lower and
2 is upper tensiometer). However, Peters et al. (2015) showed that only in the beginning
of the measurement, when the suction distribution is close to the hydrostatic conditions,
the arithmetic mean of the suctions is preferable. In later stages, the suction distribution
becomes highly nonlinear. Then the geometric mean for the two tensiometers is preferable
(Equation 4):
h geo,i−1/ 2 =

(h

1,i

+ h1,i−1 ) + ( h2,i + h2,i−1 )

Equation 4

2
To get the most appropriate mean suction at any time, Peters et al. introduced the mixed
mean, which is given by Equation 5:
h mix ,i−1/ 2 = ω avg h ari ,i−1/ 2 + (1− ω avg ) h geo,i−1/ 2

Equation 5

where wavg [–] is a weighting parameter that controls the shift from the arithmetic to the
geometric mean. As a weighing parameter, HYPROP-FIT simply uses the inverse to the
SEM-approximated gradient in suction ∇h (Equation 6):
ω avg =

1
∇h

Equation 6

For conditions close to hydrostatic conditions, where the approximated gradient of the
suction ∇h: is close to unity, h mix , i−1/ 2 is close to the arithmetic mean, whereas in later stages
of the experiments, when the suction distribution in the column is highly nonlinear, h mix ,i−1/ 2 is
close to the geometric mean. The HYPROP-FIT calculates the retention data always between
two interpolated times and not for the interpolated time steps. This is done to get exact data
triplets for water contents, suctions, and conductivities. The calculation of conductivity data
relies on flux data and thus, requires the data at two different time steps (Equation 7).
For the calculation of unsaturated hydraulic conductivity, K [cm d-1], first estimate the water
!
−1
= 11/2(t
/ 2(tii−1
flux at the column center, q c ⎡⎣⎢ cm d ⎤⎦⎥ . For any timett−1/
ti-1/2
)q! c is assumed to be half of
-1 + ttii)
2
-1
the evaporation rate q0[cm d ] (Equation 7):

q̂c, i–1/2 =

q0, i–1/2 L Lθi – θi–1
=
2
2| ∆ ti–1/2

Equation 7

where Δti−1/ 2 = ti −ti−1 and i runs from 2 to N, the number of data points. The mean gradient of
the hydraulic head at the center of the column is then approximated as shown in Equation 8:
∇Hi–1/2 =

h1,i–1/2 – h2,i–1/2
z2 – z1

–1

Equation 8

where h1,i–1/2 and h2,i–1/2 are the mean suctions at the two depths z1 [cm] and z2 [cm] in the
time interval Δti−1/ 2 which are calculated by the arithmetic mean in time. The hydraulic
conductivity K [cm d-1] is then calculated according to the Darcy-Buckingham law as shown in
Equation 9:
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K i−1/ 2 =

q! c ,i−1/ 2
∇H i−1/ 2

Equation 9

These conductivity data are assigned to mean suctions h to obtain data for K(h). Thus, at
each time ti−1/ 2 a triplet of data points for h,θ and K is obtained leading to a full set of q(h),
K(h), K(q).
As previously described, HYPROP-FIT offers three approaches to calculate the mean suction
h, the arithmetic, geometric, and mixed mean. It is strongly recommended to use the mixed
mean, which is also the default.
A limitation of the evaporation method is that at the beginning of the experiment, the
hydraulic conductivities are usually much higher than the fluxes, and the gradients of the
hydraulic head ∇H are therefore small. Because of inevitable noise of tensiometer
measurements reflecting measurement and calibration error, very small gradients cannot be
resolved and hydraulic conductivities, which are much higher than the flux q, cannot be
determined with sufficient accuracy. To account for this, the criterion used by Peters and
Durner (2008) is applied to reject all data that are calculated from gradients smaller than
6σh /Δz, where σh is the measurement noise of the tensiometer readings.
NOTE: In HYPROP-FIT 3.0 the default value for the tensiometer uncertainty is set to σh = 0.15 hPa. This means
that even small systematic offset shifts in tensiometer readings can easily lead to erroneous results and must be
strictly avoided. If set properly, suctiony must differ in the initial phase of an evaporation experiment, when almost
hydrostatic conditions prevail, by exactly 2.5 cm.
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Appendix B. INITIAL WATER CONTENT
AUTOMATIC ESTIMATION
After a measurement campaign, the initial water content is determined precisely from
subtracting all tare weights from the total mass of the measuring assembly (i.e., by
subtracting the tare weight of sensor unit), the mass of the sampling ring, and the mass
of the dry soil, obtained after drying for 24 h at 105 °C. If this value is not yet available, a
guess of the initial water content can be obtained using the HYPROP-FIT software using
Equation 10,
θs = 1−

m0 −ρ w ×Vtot
(ρs −ρw )×Vtot

Equation 10

where
qs (cm3 cm-3) is the saturated volumetric water content, equal to the porosity and assumed to
be the initial water content
pw (g cm-3) is the density of water, taken to be 1.0 g cm-3
ps (g cm-3)

is the density of the soil matrix

Vtot (cm )

is the volume of the soil sample

3

m0 (g) is the mass of water plus soil at the beginning of the experiment (i.e., at full
saturation)

The value is taken from the total recorded weight at the start line, whereas all other values
are specified in the Information register.
This calculation assumes that all pores are water filled, so that the porosity is equal to the
saturated water content. Since this is rarely the case in real evaporation measurements, this
approximation is only a reasonable initial guess. An accurate calculation requires weighing
the dry soil and inserting the respective value in the menu Calculation of water contents in
the Evaluation register.
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Appendix C. SHYPFIT2.0 USER'S MANUAL
Authors: Andre Peters and Wolfgang Durner, 2015
Cite as: Peters, A. and Durner, W. (2015). SHYPFIT 2.0 User’s Manual. Research Report.
Institut für Ökologie, Technische Universität Berlin, Germany.
HYPROP-FIT uses SHYPFIT2.0 for selecting and fitting different soil hydraulic models to the
data. The model structure in SHYPFIT2.0 follows the PDI model suggestion, which combines
water retention and conductivity in completely and incompletely filled capillaries as well
as isothermal vapor conductivity (Peters, 2013; Iden and Durner, 2014; Peters, 2014). The
commonly used retention models of van Genuchten (1980), Kosugi (1996) or the bimodal
model of Durner (1994) in combination with the Mualem (1976) hydraulic conductivity model
are given as special cases of the general PDI models as will be outlined below.

C.1 PDI MODEL COMBINATIONS
This section describes PDI model combinations.

C.1.1 RETENTION FUNCTIONS
This section describes retention functions.
C.1.1.1 GENERAL
The general form of the PDI retention model is given by the sum of capillary and adsorptive
water retention (Peters, 2013; Iden and Durner, 2014):
θ( h ) = ( θs −θr )S cap + θr S ad

Equation 11

Where
q [–] is the volumetric water content
h [cm] is the suction
cap

S

[–] and Sad [–] are the saturation of capillary and adsorptive water retention

qs [–] is saturated water content
qr [–] is the maximum water content for water adsorption

Capillary retention q cap (h) is given by the first term on the right side of Equation 11 and
adsorptive retention q ad (h) by second term. Setting Sad to 1 gives the original capillary
retention functions with residual water content. A typical unimodal PDI soil water retention
function is shown in Figure 58.
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Figure 58 Typical unimodal lPDI soil water retention function. The capillary part is here expressed as
qcap* = qcap + qr. Thus qcap* resembles the classic soil water retention function with residual water content.

C.1.1.2 ADSORPTIVE SATURATION FUNCTION
The saturation function for water adsorption is given by a smoothed piecewise linear
function (Iden and Durner, 2014):
S ad ( x ) = 1+

⎡
⎛ x − x ⎞⎟⎤ ⎫⎪⎪
1 ⎧⎪⎪
⎟⎥ ⎬
⎨ x − xa + b In ⎢⎢1+ exp ⎜⎜⎜ a
⎜⎝ b ⎟⎟⎠⎥⎥ ⎪⎪
xa − xb ⎪⎪
⎢
⎣
⎦⎭
⎩

Equation 12

Where x = pF = log10 (h in cm), xa = log10 (ha) and x0 = log10 (h0) with ha being the suction at air
entry for the adsorptive retention and h0 being the suction, where the water content is 0.
The parameter h_a is given as 1/alpha for the unimodal van Genuchten saturation functions
and set to h_m for the basic Kosugi function. For the bimodal functions, h_a is derived from
the highest value of alpha and the lowest value for h_m, corresponding to the coarsest
subfunctions. The parameter h might be set to 106.8 cm, which is the suction at oven dryness
for 105 °C (Schneider and Gnoss, 2012). The smoothing parameter b is dependent on the
capillary saturation function Scap, which is described in Section C.1.1.3.
C.1.1.3 CAPILLARY SATURATION FUNCTION
The formulation of the saturation function for capillary saturation, Scap must ensure that
the water content is 0 at h = h0. This is guaranteed by scaling the basic classic saturation
functions, G (h) (e.g., van Genuchten, 1980, Kosugi, 1996):
S cap ( h ) =

Γ ( h )−Γ 0
1−Γ 0
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Where G0 is the basic function at h = h0. Setting G0 = 0 yields the original capillary saturation
functions where:
S cap ( h ) = Γ ( h )

Equation 14

Thus, SHYPFIT2.0 distinguishes between scaled (Equation 13) and unscaled (Equation 14)
capillary retention. The effect of scaling according to Equation 13 is exemplarily shown
for the van Genuchten function in Figure 59. For small values for n (i.e., wide pore size
distributions) the saturation of unscaled function does not reach a value of 0 at oven dryness
at h = h0.

Figure 59 Effect of scaling the capillary retention function according to Equation 13 using the van
Genuchten function as basic function. Unscaled is the original Scap (h) = G(h) function and scaled means
Scap (h) =(G(h)–G0)/(1–G0). Numbers indicate different values for n.

The basic functions implemented in SHYPFIT2.0 are the constrained and unconstrained
unimodal function of van Genuchten (1980), the unimodal function of Kosugi (1996) and
part of the original Fredlund and Xing (1994) function. Each of the functions is also given
in the bimodal form (e.g., Durner, 1994 for the van Genuchten function and Romano et al.,
2011 for the Kosugi function). The constrained function of van Genuchten (1980) is given by
Equation 15:
⎤
⎡
⎢
⎥
1
Γ( h )= ⎢
⎥
⎢ 1+ (αh)n ⎥
⎥⎦
⎣⎢

1−1/ n

Equation 15

Where α[1/cm] and n [-] are curve shape parameters. The unconstrained function of van
Genuchten (1980) is given by Equation 16:
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⎤
⎡
⎢
⎥
1
Γ( h )= ⎢
⎥
⎢ 1+ (αh)n ⎥
⎢⎣
⎥⎦

m

Equation 16

Where m [–] is an additionally shaped parameter. The unimodal Kosugi retention function is
given by Equation 17:
m

⎡ ⎛ h ⎞⎤
⎢ ln⎜⎜ ⎟⎟⎟ ⎥
⎢ ⎜⎜ h ⎟ ⎥
1
⎝ m ⎠⎥
Γ ( h ) = erfc ⎢⎢
⎥
2
Equation 17
⎢ 2σ ⎥
⎢
⎥
⎢⎣
⎥⎦
Where h_m is the suction corresponding to the median pore radius, σ [–] is the standard
deviation of the log-transformed, pore-size distribution density function and erfc [–]
denotes the complementary error function. The basic Fredlund and Xing function is given by
Equation 18:
⎡
⎤
1
⎢
⎥
Γ( h )= ⎢
⎥
⎢ In {e + (αh)} ⎥
⎣
⎦

m

Equation 18

where ∝ [1/cm] n [–] and m [–] are curve shape parameters and e [–] is the Euler number
(e ≈ 2.718 ).
The bimodal functions are weighted sums of the unimodal functions Equation 19:
2

Γ ( h ) = ∑ i=1 wiΓ i

Equation 19

Where Gi are the weighted subfunctions of the system, expressed by one of the unimodal
functions and wi [–] are the weighting factors for the subfunctions, subject to 0 < wi < 1 and
Σwi = 1. Thus three basic functions, which are either uni- or bimodal are implemented. These
functions can be scaled according to Equation 13 or not scaled. Furthermore, the adsorption
function might be added or not (in that case Sad in Equation 11 is simply set to 1). All in all
this gives 24 combinations for the soil water retention function (basic functions: 3; modality:
2; scal: 2; ads: 2) are possible (see Table 15). The unscaled unimodal van Genuchten function
without adsorption (first line in Table 15) is the original van Genuchten function. The shape
parameter b for the adsorption function (Equation 11) is given by Equation 20:
b = 0.1+

2
⎧
⎛
⎞ ⎫⎪
0.2 ⎪⎪⎪
⎜⎜− θr ⎟⎟ ⎪⎪
1−
exp
⎨
⎜⎜ θ −θ ⎟⎟ ⎬⎪
n2 ⎪⎪
⎝ s
r⎠ ⎪
⎪⎩
⎪⎭

Equation 20

for the constrained and unconstrained van Genuchten and Fredlund and Xing functions and by
Equation 21:
2⎫
⎪⎧⎪
⎛
θ ⎞ ⎪⎪
b = 0.1+ 0.07σ ⎪⎨1− exp ⎜⎜⎜− r ⎟⎟⎟ ⎪⎬
⎪⎪
⎜⎝ θs −θr ⎟⎠ ⎪⎪
Equation 21
⎪⎩
⎪⎭
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for the Kosugi function. For the bimodal functions, n and σ are taken from the coarsest
subfunction (i.e., the subfunction with highest value for α or the lowest value for hm).
Figure 60 shows a bimodal scaled water retention function with capillary and adsorptive part.

Figure 60 Typical bimodal PDI soil water retention function. The capillary part is here expressed as
qcap* = qcap + qr. Thus qcap* resembles the classic soil water retention function with residual water content.

C.2. CONDUCTIVITY FUNCTIONS
This section describes the conductivity functions.

C.2.1 GENERAL
To be valid for the complete moisture range, the liquid hydraulic conductivity model is given
by a sum of capillary and film conductivity as shown in Equation 22 (Peters, 2013):
cap
K = K s ⎡⎢(1− ω ) K rel
(S cap ) + ωK relfilm (S cap )⎤⎥⎦
⎣

Equation 22

cap ⎡ ⎤
ad ⎡ ⎤
Where Ks [cm/d] is the saturated liquid conductivity and K rel
⎣⎢−⎦⎥ and K rel ⎣⎢−⎦⎥ are relative
conductivities for capillary and film flow.

C.2.2 CAPILLARY CONDUCTIVITY
Relative conductivity for capillary flow is described by the pore bundle model of Mualem. The
Mualem model for the capillary retention function is given by Equation 23:
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⎡ S cap 1 cap* ⎤
⎢
dS ⎥
τ ⎢∫
cap
K rel
(S cap ) = (S cap ) ⎢⎢ 0 1 1h cap* ⎥⎥⎥
⎢ ∫0 dS
⎥
h
⎣
⎦

2

Equation 23

Where τ [-] is the tortuosity and connectivity parameter and Scap* is a dummy variable of
integration. Except for the unconstrained van Genuchten variants there exist analytical
solution for all above mentioned soil water retention functions.
C.2.2.1 ANALYTICAL SOLUTIONS FOR UNSCALED CAPILLARY RETENTION FUNCTIONS.
For the unscaled capillary retention functions Scap = G. In these cases the analytical solutions
are given by Equation 24:

K

cap
rel

= (S

)

τ

cap

m⎤
⎡ ⎛
1/ m
⎢1−⎜1−( S cap ) ⎞⎟⎟ ⎥
⎟⎠ ⎥
⎢ ⎜⎝
⎥⎦
⎢⎣

2

Equation 24

for the constrained van Genuchten function (Equation 25),

K

cap
rel

= (S

cap

)

τ

⎡1
⎤⎤
⎡
⎢ erfc ⎢ erfc−1 −(2S cap ) + σ ⎥ ⎥
⎢2
⎢
2 ⎥⎦ ⎥⎥⎦
⎢⎣
⎣

2

mi ⎤
⎡
1/ m
⎢ ∑ 2 w α ⎛⎜1−( S cap ) i ⎞⎟⎟ ⎥
τ ⎢
i
⎟
i=1 i i ⎜
⎝
⎠ ⎥⎥
⎢1−
2
⎥
⎢
∑ i=1 wiαi
⎥
⎢
⎥
⎢
⎦
⎣

2

Equation 25

for the Kosugi function (Equation 26),

cap
K rel
=

(∑

k
i=1

wi Sicap

)

Equation 26

for the bimodal van Genuchten function, and (Equation 27)

cap
K rel
=

(∑

k
i=1

wi Sicap

2
2
⎡ 2
⎡
σ ⎤⎤
2
e σi / 2
e σi / 2
⎢
w
−
w
erf ⎢ erfc−1 (2Γ i ) + i ⎥ ⎥⎥
∑
∑
i
i
⎢
i=1
i=1
⎢
τ
2hm,i
2hm,i
2 ⎥⎦ ⎥
⎢
⎣
⎢
⎥
σi2 / 2
⎢
⎥
2
e
⎢
⎥
2∑ i=1 wi
⎢
⎥
2h
m,i
⎣
⎦

2

)

Equation 27

for the bimodal Kosugi function.
C.2.2.2 ANALYTICAL SOLUTIONS FOR SCALED CAPILLARY RETENTION FUNCTIONS.
For the scaled capillary retention functions, the Mualem model can be written as
(Peters, 2014) shown in Equation 28:
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⎤
⎡ Γ1
⎢
dΓ * ⎥
τ ⎢ ∫Γ
cap
K rel
(S cap ) = (S cap ) ⎢⎢ 10 1h ⎥⎥⎥
dΓ * ⎥
⎢∫
⎥⎦
⎢⎣ Γ 0 h

2

Equation 28

where and G * is a dummy variable of integration. This leads to the following general solution:
K

cap
rel

(S ) = (S )
cap

cap

τ

2

⎡ F (Γ ) − F (Γ ) ⎤
0 ⎥
⎢
⎢ F 1 −F Γ ⎥
( 0 ) ⎥⎦
⎢⎣ ( )

Equation 29

1

where F (G ) is the solution of the indefinite integral ∫ h dΓ × F (Γ ) for the unimodal constrained
van Genuchten and for the unimodal Kosugi function are given by:
m

F (Γ ) = −α(1−Γ 1/ m )

Equation 30

and
2

eσ / 2
F (Γ ) = −
erf
2hm

⎤
⎡
⎢ erfc−1 (2Γ ) + σ ⎥
⎢
2 ⎥⎦
⎣

Equation 31

where erfc-1 is the inverse of the complementary error function. For the bimodal van
Genuchten and Kosugi functions (Durner, 1994 and Romano et al., 2011) F(T) is given by:

(

2

mi

)

Equation 32

⎡
⎤
⎢ erfc−1 (2Γ ) + σi ⎥
i
⎢
2 ⎥⎦
⎣

Equation 33

F (Γ ) = −∑ i=1 wiαi 1−Γ i1/ mi
and
2

eσ / 2
F (Γ ) = −∑ i=1 wi
erf
2hm,i
2

Equation 29 through Equation 33 yield the following solutions for the capillary
conductivity function:
cap
K rel
= ( S cap )

τ

m⎤
⎡ ⎛
⎢ ⎜1−Γ 1/ m ⎞⎟⎟ ⎥
⎢1−⎜⎜
⎟ ⎥
⎢ ⎜⎝1−Γ 01/ m ⎟⎟⎠ ⎥
⎥⎦
⎢⎣

for the basic van Genuchten function,
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⎡
⎞⎤
⎛
⎢ F − erf ⎜⎜erfc−1 (2Γ ) + σ ⎟⎟⎟ ⎥
0
⎢
⎜
τ
⎝
2 ⎟⎠ ⎥⎥
cap
K rel
= ( S cap ) ⎢⎢
⎥
1+ F0
⎢
⎥
⎢
⎥
⎢⎣
⎥⎦

2

Equation 35

with
⎡
σ ⎤⎥
F0 = erf ⎢ erfc−1 (2Γ 0 ) +
⎢
2 ⎥⎦
⎣

Equation 36

for the basic Kosugi function,

cap
K rel
=

(∑

k
i=1

wi Sicap

⎡
2
1/ m
⎢ ∑ i=1 wiαi 1−Γ i i
⎢1−
⎢
2
1/ mi
⎢ ∑ i=1 wiαi 1−Γ 0,i
⎢⎣

(
(

)

τ

⎤
⎥
⎥
mi ⎥
⎥
⎥⎦
mi

)
)

2

Equation 37

for the bimodal van Genuchten function and

i

i

τ F0 – ∑

⎛
⎝

⎛∑k 2 S
⎝ i=1

cap

⎛
⎝

2
i

m,i

2
∑i=1
w

⎛
⎝

cap
Krel
=

σi
eσ /2
2
erf erfc–1 2Γi +
2i
i=1
√2
2h

2

eσ /2
+ F0
2hm,i

Equation 38

⎡
⎤
⎢ erfc−1 (2Γ ) + σi ⎥
0
⎢
2 ⎥⎦
⎣

Equation 39

2
i

i

with
2

2

F0 = ∑ i=1 wi

e σi / 2
erf
2hm,i

For the bimodal Kosugi function.
NOTE: For G0 = 0, Equation 35 through Equation 39 reduce to Equation 24 through Equation 27. In cases of using the
unconstrained uni- or bimodal van Genuchten or Fredlund and Xing functions, the capillary bundle model of Mualem
(Equation 28) is solved numerically.

C.2.3 FILM CONDUCTIVITY
The relative conductivity for water flow in films is given by Equation 40 (Peters, 2013):

⎛ h ⎞⎟ (
film
K rel = ⎜⎜⎜ 0 ⎟⎟
⎜⎝ ha ⎟⎠

a 1−S ad
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where a [–] is the slope on the log-log scale, which might be fixed to –1.5 (Tokunaga, 2009;
Peters, 2013).

C.2.4 PREDICTION OF ISOTHERMAL VAPOR CONDUCTIVITY
SHYPFIT2.0 allows optional to ad isothermal vapor conductivity to liquid hydraulic
conductivity. In that case total hydraulic conductivity is given by Equation 41:
cap
K = K s ⎡⎢(1− ω ) K rel
(S cap ) + ωK relfilm (S ad )⎦⎥⎤ + K vap
⎣

Equation 41

The isothermal vapor conductivity Kvap is calculated according to Saito et al. (2006) as shown
in Equation 42:
K vap =

ρsv Mg
D
H
ρ w RT r

Equation 42

Where rsv [kg/m-3] and rw [kg/m-3] (rw = 1000 kg/m-3) are the saturated vapor density and
the liquid density of water, M [kg/mol-1] (M = 0.018015 kg mol-1) is the molecular weight of
water, g [m s-2] (g = 9.81 m s-2) is the gravitational acceleration, R [j mol-1 Kg-1] (R = 8.314 J
mol-1 Kg-1) is the universal gas constant, T [K] is the absolute temperature, D [m2 s-1] is the
vapor diffusivity and Hr [–] is the relative humidity. D is dependent on water content and is
calculated according to Saito et al. (2006) using Equation 43:

D = ξθa Da

Equation 43

Where Qa [–] is the volumetric air content, for simplicity given by: theta_a = theta_s – theta,
Da [m2 s-1] is the diffusivity of water vapor in air and ξ [–] is the tortuosity factor for gas
transport, calculated according to Millington and Quirk (1961) shown in Equation 44:

ξ=

θa7 / 3
θs2

Equation 44

Da and psv are dependent on temperature (Equation 45):
2

⎛ T ⎞⎟
⎟
Da = 2.14×10−5 ⎜⎜
⎜⎝ 273.15 ⎟⎟⎠

Equation 45

⎛
⎞
6014.79
ρsv = 10−3 exp ⎜⎜⎜31.3716−
−7.92495×10−3 T ⎟⎟⎟T −1
⎟⎠
T
⎝

Equation 46

and (Equation 46)

Hr is calculated with the Kelvin equation (Equation 46):
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⎛ hMg ⎞⎟
⎟
H r = exp ⎜⎜
⎜⎝ RT ⎟⎟⎠

Equation 47

Figure 61 shows total hydraulic conductivity and the single parts for an unimodal and
bimodal capillary retention function.

Figure 61 Total hydraulic conductivity for unimodal (left) and bimodal
(right) capillary retention function

C.3. CAPACITY FUNCTIONS
The soil water capacity function is defined as in Equation 48:
C ( h) =

dθ
dh

Equation 48

The general form of the PDI capacity function is calculated with Equation 49
C ( h) = (θs −θr )

dS cap
dS ad θs −θr dΓ
dS ad
+ θr
=
+ θr
dh
dh
1−Γ 0 dh
dh

Equation 49

where the derivative of the adsorptive saturation is given by using Equation 50:
⎡
⎛ x − x ⎞⎟ ⎤
⎢
⎟ ⎥
exp ⎜⎜⎜ a
⎢
⎜⎝ b ⎟⎟⎠ ⎥⎥
1
dS
⎢
=
1−
⎛ x − x ⎞⎟ ⎥⎥
dh
h In(10)( xa − x0 ) ⎢⎢
⎜ a
⎢ 1+ exp ⎜⎜⎜ b ⎟⎟⎟ ⎥
⎝
⎠ ⎥⎦
⎢⎣
ad

Equation 50

The difference between the derivatives of the scaled and unscaled capillary saturation
functions is only the denominator 1 – Γ 0 which is 1 for the unscaled function. Therefore, the
derivatives are given for the unscaled functions. The derivatives are (Equation 51):
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− m+1)
n−1 ⎡
n⎤ (
dΓ
= −αnm(αh) ⎢1+ (αh) ⎥
dh
⎣
⎦

Equation 51

for the unimodal van Genuchten function (Equation 52),
⎡ ⎡ ⎛ ⎞⎤ 2 ⎤
⎢ ⎢ ⎜ h ⎟⎥ ⎥
⎢ ⎢ In⎜⎜ ⎟⎟⎟⎥ ⎥
⎢ ⎢ ⎜⎝ hm ⎠⎥ ⎥
1
dΓ
⎦ ⎥
=
exp ⎢− ⎣
2
⎢
⎥
dh
2σ
2πσh
⎢
⎥
⎢
⎥
⎢
⎥
⎣
⎦

Equation 52

for the unimodal Kosugi function (Equation 53),

{

n
n
⎡
⎤
mn(αh) ln ⎢(αh) + e⎥
dΓ
⎣
⎦
=
n
dh
h(αh) + eh

}

−m−1

Equation 53

For the basic Fredlund and Xing function and simply (Equation 54)

dΓ i
2
dΓ
= ∑ i=1 wi
dh
dh

Equation 54

for the bimodal functions.

C.4. OTHER SOIL HYDRAULIC FUNCTIONS
The hydraulic functions summarized in Section C.1encompass most of the commonly used
soil hydraulic functions (such as the original van Genuchten, Kosugi and Durner functions)
and extend them to account for water retention and conductivity in incompletely filled pores
as well as for isothermal vapor conductivity. Sometimes other models which are not part of
the PDI model family are required such as the Brooks and Corey (1964) model or the model
from Fredlund and Xing (1994). These two models are outlined here.

C.4.1 BROOKS AND COREY FUNCTION
The Brooks and Corey retention function is given by Equation 55:

Se ( h) =

{

−λ

(αh)

for h>α−1

1

for h≤α−1

Equation 55

where α [1/cm] is the inverse of the air entry value, λ [–] is the pore size distribution index
and Se is the effective saturation given by Se = (Q - Qr) / (Qs - Qr) with Qs and Qr are saturated
and residual water contents.
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Based on similar capillary bundle considerations as the Mualem model, the combination of
the Brooks & Corey retention function with the Burdine conductivity model (Burdine, 1953)
gives (Brooks and Corey, 1964) Equation 56:
2

K ( h) = {

+τ+2
−λ ⎤ λ
⎡
K s ⎢(αh) ⎥
⎢⎣
⎥⎦
Ks

for h>α−1
for h≤α−1

Equation 56

As for the Mualem model, the slope of the conductivity function vs. pF is determined by the
pore-size distribution parameter of the retention function, and additionally by a tortuosity
parameter [–], which is regarded as fitting parameter.
The capacity relation for the Brooks and Corey function is given by Equation 57:
λ

−λ

(θs −θr ) h(αh)

C ( h) = { 0

for h>α−1
for h≤α−1

Equation 57

C.4.2 ORIGINAL FREDLUND AND XING MODEL
The Fredlund and Xing (1994) soil water retention model accounts for zero water content at
oven dryness by Equation 58:
θ ( h) = θsΧ ( h)Γ ( h)

Equation 58

with Equation 59

{

n⎤
⎡
Γ ( h) = In ⎢ e + (αh) ⎥
⎣
⎦

}

−m

Equation 59

and Equation 60
Χ ( h) = 1−

In(1+ h / hr )

In(1+ h0 / hr )

Equation 60

where α, n, m, and hr are curve shape parameters and e is the Euler number. For the Fredlund
and Xing retention model there exists no analytical solution for the Mualem capillary bundle
model. Therefore, Equation 28 is solved numerically.
The capacity function for the Fredlund and Xing retention model is Equation 61:
C ( h) =

dΧ
dΓ
Γ+
Χ
dh
dh

where Equation 62
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dΧ
=
dh

1
⎛ h ⎞
(h + hr )ln⎜⎜⎜⎜ h −r h ⎟⎟⎟⎟
⎝ r
0⎠

Equation 62

and Equation 63

{

n
n
⎤
⎡
mn(αh) ln ⎢(αh) + e⎥
dΓ
⎣
⎦
−
=
n
dh
h(αh) + eh

Table 15

}

−m−1

Equation 63

Summary of All Implemented Model Combinations In SHYPFIT2.0
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m

vGm

uni

no

yes 3101

a

n

w

qs

Ks

t

h0

w

a

m

vGm

uni

yes

yes 3111

a

n

w

qs

Ks

t

h0

w

a

m
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Table 15

Summary of All Implemented Model Combinations In SHYPFIT2.0 (continued)

Basic Mod Scal Ads Code

1

2

vGm

bi

no

no 1200

a

n

vGm

bi

yes

no 1210

a

n

vGm

bi

no

yes 1201

a

n

vGm

bi

yes

yes 1211

a

4000

BC//
Bur

3

4

5

6

7

8

9

10

11

12

13

14

qr

qs

Ks

t

—

—

—

a2

n2

wc

m

m2

—

qs

Ks

t

h0

—

—

a2

n2

wc

m

m2

w

qs

Ks

t

h0

w

a

a2

n2

wc

m

m2

n

w

qs

Ks

t

h0

w

a

a2

n2

wc

m

m2

ha

l

qr

qs

Ks

t

5000

a

n

hr

qs

Ks

t

h0

m

n2

wc

m

m2

FX

uni

FX

uni

yes

yes 5111

a

n

hr

qs

Ks

t

h0

w

a

m

FX

uni

yes

yes 5211

a

n

hr

qs

Ks

t

h0

w

a

a2

a

Basic—Basic functions

b

vG—van Genuchten constrained

c

Kos—Kosugi

d

vGm—van Genuchten unconstrained

e

Mod—Modality

f

uni—unimodal

g

bi—bimodal

h

Scal—Scaling

i

Ads—Adsorption
Information in the preceding list are either considered or not considered. If Ads is considered, film conductivity is
considered as well.

NOTE: The greyed out models are not directly implemeted in HYPROP-FIT.

C.5. PARAMETER ESTIMATION
The following section describes the parameter estimation.

C.5.1 DEFINITION OF OBJECTIVE FUNCTION

The parametric models for θ (h) and K(h) are fitted simultaneously to the data points. This
is essential as distinct parameters (e.g., α and n for the van Genuchten/Mualem model)
influence the shape of both functions. The fitting is accomplished by a nonlinear regression
algorithm by minimizing the sum of weighted squared residuals between model prediction
and data pairs:
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2
r
r
Φ (b) = ωθ ∑ i=1 ωθ ,i ⎡⎢θ l −θ! i (b)⎤⎥ + ω K ∑ i=1 ω K ,i ⎡⎢ K i − !
K i (b)⎤⎥
⎣
⎦
⎣
⎦

2

Equation 64

where r and k are the number of data pairs for the retention and the conductivity function,
respectively, wθ and wK are the class weights of the water content data and conductivity
data, wθ, i and wK,i are the weights of the individual data points, and θ i ,θ! i (b) ,K i , and K i (b) are
the measured and model predicted values, respectively and b is the parameter vector. In
SHYPFIT2.0 either the combination of θ (h) and K(h) models or only one of them can be fitted
to the measured data. In the latter case the first or second part of Equation 64 vanishes.
The parameter estimation procedure must guarantee that the best parameter combination for
the appropriate model combination is found (i.e., the global minimum in the multidimensional
parameter space must be determined). Often local estimation algorithms such as the
Levenberg-Marquardt algorithm (Marquardt, 1963) are used for parameter estimation.
However, especially for complex models with many degrees of freedom these algorithms fail to
find the optimal parameter vector so that the outcome of these algorithms largely depends on
the initial guesses. Therefore, SHYPFIT2.0 uses the shuffled complex evolution algorithm (SCE)
(Duan et al., 1992), which is a global parameter estimation algorithms.
One crucial part is the choice of the correct boundaries for the parameters. In
SHYPFIT2.0 the boundaries of the parameters for each model combination have default
values, which might be changed by the user if necessary. The predefined boundaries
are chosen in a way, which shall guarantee high flexibility on the one hand and physical
consistency on the other hand. To guarantee both for the parameter of the Mualem
conductivity model (Equation 28), the lower allowed boundary of tau can be expressed as a
function of the pore-size distribution parameters of the retention function as described by
Peters et al. (2011). For the unscaled uni- and bimodal van Genuchten retention functions,
the lower allowed value is given by: tmin = 1 − 2/m and tmin = 1 − 2min |1/mi |, respectively.

C.5.2 INTEGRAL VERSUS CLASSIC FIT

For Equation 64, the predicted water contents, θ! i , are either calculated in a standard manner
as the point water contents at pressure head hi , (classic method), or as the mean water
content of the column, calculated as the integral of the water content distribution over the
soil column divided by its height (integral method).
In the case that the measured water contents and pressure heads are regarded as point
measurements in the soil they are treated as simple points of the fitted soil water retention
function. This scheme is called the classic method.
In the case of hydrostatic column experiments or when evaporation experiments are
conducted and the water contents are measured as mean water contents in the whole soil
column with a scale, Peters and Durner (2006, 2008a) introduced the so called integral
method. This is done since the assumption that the water content is spread out linear
over the column is not always fulfilled in coarse pored or structured soil. Effectively, the
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measured mean water content of the column is the integral of the water content distribution
over the whole column divided by the volume of the column. With the assumption of
hydraulic equilibrium (for hydrostatic experiments) or quasi equilibrium (for the early stage
of evaporation experiments (Peters and Durner, 2008a)) this is in the one-dimensional
case the same as the integral of the retention function over the matric heads from the
lower boundary of the column to the upper boundary divided by the height of the column.
Therefore, we have to replace in Equation 64 the model predicted point water content θ! i (b) by
the model predicted mean water content:

!
1 hub ,i
θ i (b) = ∫ θ! (b,h) dh
L hlb ,i

Equation 65

where L [cm] is the column height, and hub,i and hlb,i indicate the upper boundary and lower
boundary suctions for each equilibrium state. If the option integral fit is selected, the column
length must be given. In this case, SHYPFIT2.0 interprets the measured suction as the
suction in the soil center and calculates the hub and hlb by assuming hydrostatic equilibrium,
(i.e., hub = h + L / 2 and hlb = h + L / 2).

C.5.3 WEIGHING SCHEMES
Since the objective function Φ (b) (Equation 64) involves data of different types with different
measurement frequency, the result of the optimization will likely be affected by the weights
of the data (Simunek and Hopmans, 2002). Therefore, the user can choose between three
different weighting schemes.
In the first scheme the user is fully responsible for data weighting. Each data pair will get a
single weight. No extra calculations will be carried out. If the user has prior knowledge about
measurement errors, this scheme might be used. For normally distributed uncorrelated
measurement errors with zero mean, the single weights can be set to the reciprocal of the
variance of the measurement error. This is in accordance with the maximum likelihood
principle for the method of least squares (Omlin and Reichert, 1999). In this scheme wQ and
wK are both set to unity and wq,i=1/sq,i2 and wK,i=1/sK,i2 where sq,i2 and sK,i2 are the variances of
single the measurement errors.
In the second scheme the weights are first normalized by a factor for the data type and
second by a factor for the data frequency as suggested by Peters and Durner (2008a). To
account for the different measurement frequency, the individual weights, wq,i and wK,i are
chosen such that the combined data within every log10(ℎ [cm])=pF increment have the
same weight (i.e., the weight for a certain data point is proportional to its distance to the
neighboring point on the pF scale). To account additionally for the different data types,
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the weights for the data classes are calculated by wq= 1/(qmax−qmin) and wK=1/(log10(Kmax)−
log10(Kmin)) where qmax, qmin, Kmax, and Kmin are the maximum and minimum values of the data sets
to which the models are fitted.
The third scheme is similar to the second scheme regarding the weights on the pF scale, (i.e.,
wq,i and wK,i). The weights for the different classes (i.e., wq and wK) are in this scheme given
by the user. Schelle et al. (2010), for example, set wq and wK to 1 and 0.001, respectively, and
found good results. The last two weighting schemes are only applicable in the case that no
repetitions are measured, because then different data pairs may have similar or equal pF
values, so that several data points will get weights of or close to 0.

C.6. POSTPROCESSING
The following section describes postprocessing.

C.6.1 DIAGNOSTIC VARIABLES
The first measure to evaluate the performance of the fitted model is the objective function
values at their estimated minimum, Φmin, in this case the weighted sum of squared residuals.
A more descriptive measure, giving the mean deviation between model and data is the root
mean square error, RMSE (Equation 66):

RMSE =

2
1 r ⎡
y − !y i ⎤⎥
∑
i=1 ⎢⎣ i
⎦
r

Equation 66

where yi and ŷi are measured and model predicted quantities (i.e., water contents or
hydraulic conductivities, log10(K)). For a sound representation of the data by the model, the
values of RMSE should be close to the measurement error.
The Nash-Sutcliffe index (Nash and Sutcliffe, 1970) and coefficient of determination are
calculated for both data types. The Nash-Sutcliffe index is given by Equation 67:
2

⎡ y − !y ⎤
i⎥
1 ⎢⎣ i
⎦
E = 1−
2
r⎡
∑1 ⎢⎣ yi − y i ⎥⎦⎤

∑

r

where y i is the mean measured quantity.
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The coefficient of determination (r2) is given by Equation 68:

⎡ y − y ⎤ ⎡⎢ !y − !y ⎤⎥
i⎥
i
⎣⎢ i
⎦ ⎣⎢ i
⎥⎦
r 2 = 1−
2
2
r⎡
⎤ ⎡⎢ !y − !y ⎤⎥
y
−
y
∑1 ⎢⎣ i i ⎥⎦ ⎣⎢ i i ⎦⎥

∑

r

1

Equation 68

To account for the different number of adjustable parameters when comparing different models
fitted to the same data, SHYPFIT2.0 also calculates the Akaike Information Criterion, AIC = 2(L +
k) (Akaike, 1974), where L is the likelihood function and k is the number of fitting parameters. In a
least squares estimation and with N(0,s 2) distributed residuals the information criterion, AIC, can
be expressed in the form (Equation 69) as described by Ye et al. (2008):

AlC = nln(Φmin / n) + 2k

Equation 69

where n is the number of measured data and k is the number of adjustable parameters. If the
number of measurements, n, is small in comparison to k, the original form of AIC should be
extended by a correction term that accounts for small values for n/k (Hurvich and Tsai, 1989),
leading to the extended information criterion (Equation 70):

⎛ 2k ( k +1)⎞⎟
⎜
⎟⎟
AlCc = nln(Φmin / n) + 2k + ⎜⎜
⎜⎜⎝ n− k −1 ⎟⎟⎠

Equation 70

The first term penalizes a poor fit, the second term the number of parameters and the
third term is the correction term for small values of n/k. If n/k becomes large, the last term
becomes negligible and the AICc converges to AIC.
Since sometimes other information criteria are suggested as well, SHYPFIT2.0 calculates
also the BIC and KIC for model selection. These two are given for least square estimations
(Equation 71) as follows (Ye et al., 2008):

BlC = nln(Φmin / n) + k ln( n)

Equation 71

KlC = ( n− k )ln(Φmin / n) + kln( J T wJ )

Equation 72

and Equation 72

Where |JTwJ| is the determinant of the Fisher information matrix. J is the Jacobian or
sensitivity matrix with elements Ji,j = ∂ẑi / ∂bi where ẑi is the model prediction at point i and
bj is the j-th parameter. The superscript T indicates the transpose of the matrix and w is the
weighting matrix.
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C.6.2 UNCERTAINTY ANALYSIS
The following sections describe uncertainty analysis.
C.6.2.1 PARAMETER UNCERTAINTIES
In order to evaluate the uncertainties of the estimated parameters a linear approximation
of the covariance matrix of the estimated parameters, Cp is calculated as shown in
Equation 73 (Omlin and Reichert, 1999):

Cp ≈

−1
Φmin T
J wJ )
(
n− k

Equation 73

The linear approximation leads to a confidence interval for the i-th estimated parameter b! i by
Equation 74:

b! i ± Cρ ×tn−k ,α/ 2
i ,i

Equation 74

where tn-k,a/2 is the upper α/2 quantile of the students t-distribution with n − k degrees of
freedom. α is set to 0.05 leading to the 95% confidence interval for the parameters.
C.6.2.2 FUNCTION UNCERTAINTIES
The uncertainties for the θ (h) and K(h) functions are determined by calculating the
covariance of the model response (Equation 75), Cz:

Cz ≈ J T Cρ J

Equation 75

where the J is the Jacobian or sensitivity matrix with elements Ji,j= ∂z! i / ∂b i where z! i is the
model prediction at point i and bj is the jth parameter. The confidence interval for the model
output is given by Equation 76:

!
yi ± Cz ×tn−k ,α/ 2
i ,i

Equation 76

! ) for the retention and conductivity function,
where ŷi is the model output θ! i and log10(K
i
respectively. Again, α is set to 0.05 leading to the 95% confidence intervals for the
functional relationships.
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